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The information, figures, illustrations, tables, specifications, and schematics contained in this guide are believed to be 
correct and accurate as at the date of publication or revision. However, no representation or warranty with respect to 
such correctness or accuracy is given or implied and Kentec will not, under any circumstances, be liable to any 
person or corporation for any loss or damages incurred in connection with the use of this guide. 

The information, figures, illustrations, tables, specifications, and schematics contained in this guide are subject to 
change without notice. 

Unauthorised modifications to the software or its installation are not permitted, as these may give rise to 
unacceptable health and safety hazards. 

By installing this equipment on a computer network, the owner accepts full and unequivocal responsibility for 
ensuring that it is protected against all cyber threats and illegal tampering during the lifetime of the equipment. 
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user shall undertake no changes, modifications, conversions, translations into another computer language, or copies 
(except for a necessary backup copy). 
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limitation) incidental, direct, indirect, special, and consequential damages, damages for loss of business profits, 
business interruption, loss of business information, or other pecuniary loss, resulting from any violation of the above 
prohibitions. 

Copyright 
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1 Introduction 

The Ockular package is a powerful and sophisticated system providing graphical representation of your sites on a 
PC. Ockular® gives building managers complete monitoring and control over fire detection providing a 
comprehensive fire risk and incident management system. This guide provides information on installing and using the 
Ockular system. 

The software installation guide is based on an MS Windows 7, 32-bit installation, but Windows 8 and 10, 32-bit and 
64-bit installations are also supported.

Note: Ockular installation requires administration rights.

Note: Windows XP and Vista must not be used and are not supported.

1.1 Guides in this series 
Document Description 

Ockular Installation and 
Configuration Guide (This 
guide) 

This guide contains details on installing and using Ockular hardware and 
software.  
This guide also shows how to configure and customise the Ockular system to 
reflect individual site, area or location plans.  

Ockular User Guide This guide contains details about the day-to-day user operation of the Ockular 
system. 

Online and embedded Help Help will be available as PDF documents launched through the software Help 
button. 

1.2 Associated Manuals 
• Taktis Installation and Operation Manuals

• Syncro Installation and Operation Manuals

• Syncro AS Installation and Operation Manuals

• 3rd-party manuals provided with ancillary equipment, components and sensors

1.3 Intended Audience for this guide 
This guide is intended to be read in full by those with responsibility for installing, administering, maintaining or 
providing technical support for the Ockular system. 

1.4 How this guide should be used 
This guide should be fully read and understood before beginning the Ockular installation. Thereafter it can be used as 
a reference document as and when required. 

This guide should be used in conjunction with any 3rd-party documentation provided with ancillary equipment and 
components. 

1.5 How this guide is organised 
This guide is presented as dedicated chapters, sections and appendices, all of which are listed in a hyperlinked 
contents list in the preliminary pages. Sections and pages can also be accessed by using the pdf navigation tools, or 
you can use [Ctrl + F] to find specific words or terms. 
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1.6 Conventions used in this guide 
All guides in this series will use the same documentation conventions, as outlined below: 

Italic Documentation references are in italic text 

Bold Important information is in bold text 

[Ctrl-S] Keyboard key combinations and screen buttons are in square brackets 

<Name> Variable or user-defined names are in angle brackets 

Monospace Command line entries or paths are in highlighted monospace font 

TLA Uncommon three letter acronyms (TLA) will be preceded by their full name on first occurrence 

Click The term ‘click’ replaces the terms ‘press’ and ‘touch’ when referring to keyboard, mouse and 
touchscreen data-entry methods. 

1.7 In the Box 
Your Ockular installation package should contain the following: 

• The Media Gateway card (Taktis) or S572 card assembly (Syncro) as specified at time of order.

• USB flash drive containing Ockular software and product manuals.

• USB license dongle.

• Paper quick start guide.

Note: The USB dongle is encrypted and contains a licence for one machine only, it must remain installed for the 
Ockular 2D GUI to continue running. 

1.8 Languages 
Ockular help and user documentation are available in the following languages: 

• English

1.9 Glossaries 
Glossaries of abbreviations, acronyms, shortcuts and icons are featured in the closing sections of this guide. 
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2 Hardware Installation 
For Ockular software to function the appropriate card must be installed within the Fire Alarm Control Panel. There are two 
card versions (specified at time of order): 

• S794 Media Gateway card – Specified for Kentec Electronics Taktis Fire Alarm Control Panel.

• S572 Interface card – Specified for Kentec Electronics Syncro or Syncro AS Fire Alarm Control Panels.

Note: Supplied with the S572 is a serial to USB interface converter. 

2.1 Installing the Media Gateway Card (Taktis) 
• Power down the Fire Alarm Control Panel.

• Open the Fire Alarm Control Panel enclosure door and the fascia panel within.

• Expose the Fire Alarm Control Panel back board by removing the cover panel. The cover panel is held in place with
a single pan head screw at the base of the cover.

• Locate slot ‘F’ on the back board and insert the Media Gateway card.

• Make ethernet connections as necessary. The diagram below illustrates connections directly from a PC or over a
LAN (Local Area Network).

Fig. 1 Taktis Ethernet Connections 

• Reattach the cover panel.

• Power up the panel.

• Close the fascia and enclosure door.

Note: Adding the Media Gateway card to the panel will result in a "Media Gateway unexpected" fault. 
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Installing the S572 (Syncro) 

• Power down the Fire Alarm Control Panel.

• Open the Fire Alarm Control Panel Door.

• Fit the S572 in the available space between main board and power supply.

• Make the S572 connections using the diagram below for reference.

• Power up the panel and close the enclosure door.

Fig. 2 S572 connection diagram (Syncro) 

Note: Refer to Fig. 4 for 
connection diagram. 
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2.2 Installing the S572 (Syncro AS) 
• Power down the Fire Alarm Control Panel.

• Open the Fire Alarm Control Panel Door.

• Make the S572 connections using the diagram below for reference.

• Power up the panel and close the enclosure door.

Fig. 3 S572 connection diagram (Syncro AS) 

Note: For Syncro/Syncro AS, any panel printer must be disconnected/removed to allow inclusion of S572 board. 

Note: Refer to Fig. 4 for 
connection diagram. 
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Fig. 4 USB485-STI4W Connection Diagram
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3 Software Installation 
Installing the Ockular application also installs Openfire© instant messaging and PostgreSQL© database software as 
dependencies. 

Note: Ockular is supplied as the application and its dependencies only. Customers must supply their own data to make it 
work after installation. This data can be from a previously created project, or it can be created by using the Ockular 
design feature after installation. 

Note: The install wizard is restricted to repairing or removing Ockular if legacy artefacts are found during the install. You 
should remove the artefacts if you want to do a clean install instead of a repair. 

Ockular software is available on: 

• USB flash drive.

The latest Ockular user guides can be downloaded from: 

• Kentec Electronics Ltd. website.

The software will install in C:\\Program Files\Kentec (Windows 32 bit), or. C:\\Program Files (x86)\Kentec
(Windows 64 bit). 

3.1 Minimum System Requirements 
• Intel® Pentium™ P4 32 bit CPU (or equivalent).

• 120 Mb HDD space

• 4 Gb RAM

• Spare USB 1.0 port

• Ethernet connection

• Windows 7 Pro 32 bit

3.2 Recommended System Requirements 
• Intel® Core™ i5 64 bit CPU

• 0.5 Gb HDD space

• 16 Gb RAM

• Spare USB 2.0 port

• Ethernet connection

• Windows 7 Pro 64 bit, Windows 10 Pro 64 bit
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3.3 How to install the software 
Note: You will need IT Administrator rights to continue with the installation. 

Note: You should refer to Repairing Ockular Section if you experience any difficulties during installation. 

1. You are advised to create a System Restore Point and back up your data before proceeding.

2. Export your current Ockular configurations before carrying out an upgrade, repair, or reinstallation. (See sections 18/19
for more information).

3. Insert the installation flash drive.

Fig. 5 Ockular saved location window 

4. Click (or double click) the application to launch the installer, then accept the UAC warning and the License Agreement.

5. Choose or create a Start Menu folder (optional) and click [Next]:

Fig. 6 Select Start Menu folder dialog 

6. Remove the dongle (if fitted – see Fig.11), and then click [Install]:

Fig. 7 Security warning dialog 
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7. Wait for the software to install, and then perform the (license) Dongle Self-Test:

Fig. 8 Dongle test dialog 

8. Click [Finish] to restart the PC and initialise the software and databases:

Fig. 9 Installation completion dialog 

9. Click the Ockular desktop launch icon to start the application:

Fig. 10 Ockular desktop launch icon 

10. Consult with your IT staff if you now want to setup Ockular to automatically start whenever the PC or Server is rebooted.

Note: The Ockular Supervisor Service, Openfire and PostgreSQL are set to start and run in the background when the 
workstation is booted up. Do not disable these automatic starts as the Ockular 2D GUI must be able to connect 
with them when it is manually started. 

Note: Automatic restarts should be considered where IT systems are not using Uninterruptible Power Supplies (UPS) 
and are left unattended for any periods of time. 

Note: Ockular is designed to run permanently on and cannot record or respond to any events if it is not running. 
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4 Ockular Access 
The valid licence USB license dongle must remain in place for the duration of the Ockular session. Its removal will prevent 
fresh logins and will disable Ockular after a period of time. 

Fig. 11 USB license dongle 

4.1 To Log in to Ockular 
Ockular and its dependencies will run in the background, but you need to log in with an appropriate user account and 
password if you want to interact with the software or acknowledge alerts, silence buzzers etc. 

1. Start Ockular if it is not already running.

2. Enter your User name and Password in the Log In dialog box.

3. Click [Login].

Fig. 12 Log In Dialog 

4.2 Default User Accounts 
Ockular is supplied with some default user accounts and passwords, which should have been changed following the 
software installation. If not, they should be changed as soon as possible. Refer to section 4.7 for more details. 

The default accounts and passwords are case sensitive and are: 

Administrator admin 

Maintainer maintainer 

Manager manager 

Operator operator 

Note: Three incorrect tries will lock you out for 60 seconds. 

Note: It is advisable to have at least two Administrator accounts, as lower levels cannot change passwords or account 
details for higher levels. 

Note: All login attempts (successful or failed) are time-stamped and recorded on the Event Log. 
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4.3 User Groups 
There are four default User Groups plus optional custom user groups, and each group can be assigned with custom User 
Group tokens that are used to confer or deny access to specific Ockular components. This table is a guide to the audience 
analysis for Ockular, but Administrators can create customized user accounts or access levels to match their own 
requirements. 

Key:  = Yes,  = No 

Access Level 
Task 

3 3 2 1 0 

SysAd Maint. Manager Operator Other 

Log In      

Fire maintenance functions     - 

Access operational 
procedures     - 

View Active Events     - 

View Active Fires     - 

View Cause and Effect 
Strategy   - - - - 

Poll Device Analogue values    - - 

Manual refresh device status  - - - - 

Disable/Enable Devices     - 

Disable/Enable Zones     - 

Acknowledge Events     - 

Acknowledge Fire Events     - 

Manual Evacuation  - - - - 

Reset Fire Devices     - 

Silence Alarms     - 

Silence Buzzer     - 

System Alarm 
Acknowledgement     - 

System Alarm Un-
acknowledgement     - 

Local alarm (PC) volume 
control   - - - 

Clear Hard Faults  - - - - 

Disable/Enable Alarm 
Reporting  - - - - 

Clear Alarms  -  - - 

Find Mode  - - - - 

Select Mode     - 

Fire System Topology View  - - - - 

Export tables     - 

Generate Reports    - - 

View Historical Events     - 
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Access Level 
Task 

3 3 2 1 0 

SysAd Maint. Manager Operator Other 

View Maintenance Log    - - 

Fire Mode in 2D GUI     - 

Fire configuration   - - - 

Fire simulation mode     - 

View System Information page     - 

View Fire Management GUI     - 

Operate/Restore Outputs   - - - 

Save Column Widths     - 

Change Own Password  - - - - 

Account Management 
(Edit/Create/Delete users)   - - - 

Database management and 
editing  - - - - 

Workstation Configuration   - - - 

Use 2D Editor mode   - - - 

Exit Ockular   - - - 

Table 1. Intended User Matrix 
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4.4 To Log out or Exit from Ockular 
Only a logged in user with Administrator level access can close (exit) Ockular in a safe fashion. Using any other method 
(e.g. Ctrl-Alt-Del) could result in software corruption or loss of data. 

1. To log out, click [File] > [Log Off] > [Yes]

2. To Exit, click [File] > [Exit] > [Yes]

4.5 To change user passwords 
1. Log in to Ockular with an appropriate account level.

2. Click the [Account Management] from the left panel, select a user name (or [Add] a new one), then select [Change
Password].

3. Enter the required details in the dialog, and then click [OK].

4. Note the new details for each user account and advise them to change their passwords at first login.

Tip: Use a mixture of upper and lowercase alpha-numeric and special characters and make the password at least 8 
characters long. Use a password or phrase that is easy to remember but hard to guess. 

Fig. 13 Password change dialog 

Note: System Administrators should decide if they want to use individual user accounts, or role-based user accounts 
with shared passwords, or a mixture of the two. Individual accounts are more secure than shared accounts and 
can be used to control or block access by individuals, whereas a shared operator account might be useful where 
Ockular runs 24-7 and where control room staff circulate. 

Note: Log-ins do not automatically time-out, and all users must manually log-off at the end of their session. All login / log 
out / exit events are time stamped in the Events log, but not logging off could allow another user to perform 
unauthorised actions that will be logged in your name.
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5 Set-Up Connection to a Fire Panel 
This section describes how to setup connection between the system PC and the fire alarm control panel. 

5.1 Connect to a Taktis panel 
1. Login using Administrator level credentials.

2. Click on the Fire Configuration button on left hand panel (or from the main menu bar select view>Show Page>Fire
Configuration).

3. On the Fire Configuration Page under the Panel Comms section, enter:

• Panel Type: Taktis (EN)

• IP Address: Panel address*

*Media Gateway Card IP address can be found by accessing the LAN (Local Area Network) settings on the Taktis panel:
Engineer Options>Configuration>Edit Configuration>Panel Modules>Configure Media Gateway>LAN Settings.

4. From the Panel connectivity test, click Test to connectivity.

Note: The computer should be configured with a static IP address in the same range as the target panel IP address. Typically, 
to do this go to your computers Control Panel>Network and Sharing Centre. Select Ethernet>Properties. View the properties of 
the Internet Protocol version and use an IP address in the same range of that of the panels Media Gateway Card: 

5.2 Connect to a Syncro/Syncro AS panel 
1. Connect the USB lead from the Syncro/Syncro AS to your PC.

2. Click on the Fire Configuration button on left hand panel (or from the main menu bar select view>Show Page>Fire
Configuration).

3. On the Fire Configuration Page under the Connect to panel section, enter:

• Panel Type: Syncro or Syncro AS

• Serial Port: Comms*

*Select Comms port associated with USB panel connection. You may need to view PC device manager settings to identify
Comms port.

4. From the Panel connectivity test, click Test to connectivity.
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6 User Interface Overview 
This section provides an overview of the Ockular user interface. Familiarising yourself with the menus and terminology will 
help your understanding through the document. 

Note: The interface is highly editable, and therefore the items shown in Fig. 14 may not all be apparent on your own 
project. 

The user interface utilises a familiar, Windows style layout, as shown below: 

Fig. 14 The Basic Interface Screen 

6.1 General Toolbar Menus 
The general toolbar menu and shortcut icons follow normal Windows protocols, and gives access to the following menus: 

Fig. 15 General Toolbar Menus and shortcut icons 

Menus Icons Description 

• File

o Log Off
o Change Password…
o Exit

• View

o Show/Hide Main GUI [F5]
o Show Home Position
o Show 3D Controls (not available)
o Show Page>

 <Reflects the configuration settings button bar.>

o Show Overlay> (not available)
o Save Settings [Ctrl+S]

• Tools

o Alerts Volume

• Help

o User Manual
o Quick Guide
o Colour Key
o About

Log Off 

Toggles between the current Configuration 
GUI and the Home Screen 

Show Home position 

Launch Help 

Colour Key 

Search 

Table 2. Key to General Toolbar Menus and Icons 
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6.2 System Configuration Menu 
The System Configuration Menu is located on the upper left-hand side of the interface. Detailed information regarding 
configuration options can be found later in this document. 

Fig. 16 System Configuration Menu 

6.3 Control Mode 
The control mode tool bar is located on the upper left-hand side of the interface. Detailed information regarding control options 
can be found later in this document. 

Fig. 17 Control Mode Menu 

6.4 Editor Mode 
The control mode toggle button is located on the lower left-hand side of the interface. Further information regarding Editor 
functions can be found later in this document. 

Fig. 18 Editor Mode Toggle Button
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7 New Project Prerequisites 
Before creating a new project, it is important for inexperienced users to understand how the software organizes the 
operational part of the project, which is discussed in following sections. 

7.1 Project Images 
It is advisable to create and assemble all of the project images before starting a new project. 

This might already have been done if Ockular has been installed on other machines and the project saved to a server, in 
which case you can open the Ockular Editor, click the [Open project] button, then find and load the correct project data. 

Fig. 19 Open Project Button 

Images, symbols and icons are imported at 1:1 resolution and you then have to resize and position them before setting their 
properties.  

Ockular supports most image types, but it is advisable to convert them all to *.png for durability, and to resize icons and 
symbols to about 9 x 9 mm for consistency, clarity and ease of use. 

When you import background images you have to choose between scaling them to fit on screen or moving them around the 
screen using slider bars. 

Note: When saving projects and resources you should save them to a backed-up server where they can be accessible 
from other workstations. 

7.1.1 Image types 
You should create and save: 

• One image of the site or building for the Home page level

• Site and/or individual floor plans for the additional levels

Supported image file types are BMP, GIF, JPEG, PNG & TIFF. 

The Projects Levels section explains how to scale imported images but as a guide level images should be approximately 
2000 pixels wide 1000 pixels wide (150 pixels/inch minimum resolution). 

Note: When creating a new project, a selection of commonly used symbols are found within the symbols folder. 

7.1.2 Saving your images and icons 
In the following section you will see how using the New Project function creates and populates a basic project folder, but you 
can also manually create and populate a project folder. 

At this stage you can optionally save your own symbol images into the user folder, from where you can later import them into 
your Ockular project, and you can optionally create a third folder called ‘levels’ where you can store your levels images in 
one place for later use. 

You can create additional folders anywhere within the parent folder; e.g. you may want a separate ‘levels’ folder for your site 
and floor plans or you can just put them loosely at a higher level. 
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7.1.3 The x–y coordinate system 
The Ockular 2D GUI uses the standard x-y screen grid where the point of origin is the top left corner, and the item 
coordinates are its centre point (See Fig. 11). 

 

 

 

 

 

 

 

 

Fig. 20 Screen coordinate system 

Object centre coordinates can be offset to avoid conflicts with adjacent items. 

7.1.4 The Z-Index 
The Ockular 2D GUI uses a ‘virtual-layer’ system for ordering items according to their priority. These virtual layers are 
achieved by Ockular automatically creating ‘z-axis’ depth bands (the Z-index) as items are being added in Editing mode. 

In essence, the background image layer will always be the lowest layer, and higher priorities will always be displayed on top 
of lower priorities, as shown below: 

 

 

 

 

 

Fig. 21 Virtual Image Layers 

Note: An item’s Z-index can be manually altered in Editing mode, but this is not advisable as it could adversely affect 
other items and alert flag priorities. 

Note: Layers should not be confused with levels; levels are equivalent to floors in a building, while individual levels can 
have all of the layers shown above. 
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7.2 Panel Selection (Panel Comms) 
Ockular works with a number of different fire alarm control panel types. The following steps explains the panel connection 
process. 

1. From the Fire Configuration menu, select Fire Configuration and then Panel Comms. From the Panel Type list (1), 
select the panel type used on the fire alarm system. 

2. Select from the drop-down (2) list what serial port on your PC / IP address with the fire alarm panel is connected to.  

Note. If you don’t know what comms port is assigned, go to your PC’s Device Manager (which can be found in your 
computers Control Panel) and identify the comms port from the list of devices. 

3. Click Test (3), to verify the connection. 

 
 
 
 

7.3 Importing Loop Explorer 2 Configuration Data 
It is necessary to import the fire alarm system configuration data into Ockular. The following steps detail the process: 

1. Log in to LE2 (Loop Explorer 2) where the fire alarm system data is held. 

2. From the File tab, select Export Guide Data: 

 

Browse to the location on your computer where you wish to save the file (1). You are required to name the export 
file by entering details in the File Name field (2) and ensure the Guide (Version 2) radio button is selected (3): 

 
3. Save the file (4). 

Note: for Taktis panels the .xml configuration file can be used instead.  
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4. Return to Ockular and from the System Configuration Menu, select Fire Configuration button (1), then select the Fire 
Configuration option (2) from the list: 

 

5. Select Import… 

Browse to the location where the LE2 configuration data file is saved (.xml) and click open. The data will be imported and 
will populate the Fire Configuration Page. 

Note. If the file files fail to import it may be necessary to ‘Restart’ the service through Windows Task Manager. To perform 
this operation press [Ctrl+Alt+Delete] on the keyboard, select Task Manager, select the Services tab. From the list 
select/highlight the ASL iVENCS Supervisor Service line, right-click and select the Restart option. Return to Ockular 
software to check files have been successfully imported. 

 

 

  

1 

2 
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8 2D GUI Editor Mode 
Ockular’s editing mode can be used to design or edit site plans using a variety of shapes, texts, function buttons, and 
macros. The editing mode also allows creation or editing of item and plan level properties via panels and sub-menus (Some 
fields may have been pre-populated by the New Project wizard, but they can be edited if required). 

 

Fig. 22 Editor Mode Toggle Button 

All panels are visible and docked by default when Editor mode is first opened, but they can be dragged, floated, minimized 
or closed as required. Ockular remembers your choices until the next logoff or restart, or you can save your Editor settings 
(not the project settings) using View>Save Settings, [Ctrl-S], or [Alt-V, S]. 

Moving a panel from the dock allows the remaining panels (or background image) to take up the available space, while 
moving a panel into the dock may stack or tab the docked panels, depending on where you drag the panel into the dock 
space. 

Generally speaking, the drawing tools will be familiar to anyone who has used low-level drawing applications. 

8.1 Editor toolbars 
The Editor has dedicated toolbars that can be dragged, floated, docked or closed as required. Some of the toolbars are 
context sensitive and may not always be on view, while others that should be on view may have been hidden by a previous 
user. 

Note: Toolbars can be in landscape or portrait mode, depending on their current location. 

8.1.1 Primary editing toolbar 
The GUI Editor’s primary editing toolbar contains standardised icons (with corresponding keyboard shortcuts) that can be 
used to apply various actions to selected items. Every icon has a hover tooltip for easy identification. 

Explanations of the toolbar icons and shortcuts can be found in Appendices. 

 

Fig. 23 Primary Editing Toolbar 

 

Note: Icons are greyed out if the action cannot be applied to the current selection. 

 

8.1.2 Toolbox toolbar 
The Toolbox toolbar provides a number of standard drawing tools that are used to add items to the currently displayed level. 

Each tool may provide additional editor functions that will be displayed in the Active Tools actions toolbar. 

Each icon has a hover description, and the editor status bar (at the bottom of the screen) displays the active tool’s name. 

 

 

Fig. 24 Toolbox toolbar 

8.1.3 Editor Tools toolbar 
The context sensitive toolbar may be blank, or it may display additional controls for the selected tool, and two examples are 
shown in Fig. 25 below. 

For example, selecting a regular polygon will allow you to control the: 

• Stroke Style (none, solid, dashes, dots, etc.) 

• Stroke Weight (1 – 100 px) 

• Stroke Colour and density (RGB) 
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• Fill Style (solid, dense, horizontal stripes) 

• Fill Colour and density (RGB) 

• Number of Points (3 – 255) 

…while selecting text and button tools may allow basic text formatting options, as in the lower example below. 

 

 

 

Fig. 25 Two Examples of Editor Tools Context 
 

8.1.4 Active Tool actions toolbar 
Selecting overlapping polygons will open an additional toolbar that will allow you to merge or transect the selected objects. 
Hover over the icon for a tool description and refer to Section 9.3 for examples of how they work. 

 

 

Fig. 26 Active Tool actions toolbar 
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8.2 Project Navigator Panel 
The Project Navigator Panel has tabbed dialogs that provide quick access to the current project levels, symbols and 
subsystem object tree information. 

Project Navigator has the following tabs with their sub menus: 

• Levels tab 

o see your current plan level 
o select and view another level in the background 
o add or remove plan levels 
o edit a plan level’s properties and image 

• Symbols tab 

o drag and drop pre-defined symbols onto your selected level 
o edit your symbol libraries (import or delete symbols) 

• Object Model tab 

o select a sub-system to view 
o view Object Model paths in expandable tree view 
o view the Equipment List by item Name and JPC Path 
o hide or show items 
o Highlight orphaned items 

• Sidebar tab 

o view the plan levels that appear in the Sidebar 
o rearrange the order of levels 
o view unassigned plan levels 
o transfer levels between the unassigned and assigned lists 

Note: The item moved to the top of the Sidebar tab’s ‘allocated’ list automatically becomes the Ockular Home page, 
which will be indicated by the Home icon appearing on that level (circled below): 

 

 

 

 

 

 

 

Fig. 27 Project Navigator Panel Tabs 

• Level Properties previously selected but not saved are pink 

• Level being viewed and selected for editing is blue. 

In addition to the tabs, there are three buttons that allow you to Add or Remove levels and edit the Level’s Properties. 
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8.3 Properties Panel Overview 
The Properties Panel is a tabbed panel that allows creation or editing of a selected item’s properties. 

Note: To enable the Properties menu options, click the pointer icon and then click on the item to be edited. 
Failing to do this will result in unwanted items being added to the screen, which you can remove using Ctrl-z. 

Fig. 28 Properties Panel 

8.3.1 Properties Panel tabs 
All screen items have properties that can be created or edited in the Properties Panel tabs. Some properties automatically 
change when you move or resize items manually. 

Explanations of the different properties are shown in the tables below, but the properties are context sensitive and may not 
all be visible at the same time. 

Note: Property changes are disabled when you select multiple items at the same time. 

Base 

Property Description 

JPC Path The related subsystem equipment’s JPC path. 

Name The unique name of the item or button. 

Description Optional short description text displayed in the item status information window. 

Location Optional location name e.g. ‘Arrivals Hall’. 

Contains Path Optional comma separated list of additional subsystem JPC paths that drive the alert status 
flag. 

JPC Sources Optional comma separated list of source JPC Paths that drive the editable symbol image. 

Table 3. Base Panel Properties tab 
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Appearance 

Property Description 

Base Symbol The base symbol image name. (Symbols only) 

X The object’s normal centre point x-axis coordinate (without offset) 

Y The object’s normal centre point y-axis coordinate (without offset) 

Width The width of the item in px 

Height The height of the item in px 

Label The object’s label text (buttons and text only) 

Secondary Label The accessory label text (navigation and zone group buttons only) 

Table 4.  Properties Panel Appearance tab 

Flag 

Property Description 

Offset X 
The horizontal offset from the object’s centre point to the centre of the displayed alert flag, in 
px. Can be a positive or negative number, e.g. 50px or -50 px. 
For zones the polygon centre is offset. 

Offset Y 
The vertical offset from the object’s centre point to the centre of the displayed alert flag, in px. 
Can be a positive or negative number, e.g. 50px or -50 px. 

For zones the polygon centre is offset. 

Drop shadow Alarm flag’s drop shadow can be on or off. 

Table 5.  Properties Panel Flags tab 

Fault 

Property Description 

Transparent Faults 
Specifies if the object is transparent to faults or not. 
Transparent objects still display faults, but they are also propagated to their parent entity. 

Table 6.  Properties Panel Faults tab 
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8.3.2 Properties Panel – Drag and Drop properties 
The properties panel supports inclusive drag and drop from the object model tab (left image below). 

…or you can selectively drag and drop in the specific object model JPC path data (right image below). 

The following properties can be configured using either manual entry or drag and drop: 

• JPC Path 

• Name (JPCID) 

• JPC Sources 

 

 

 

 

 

 

 

 

 

 

 

Fig. 29 Properties Panel – Drag and Drop Properties 

8.4 Filter Items Panel overview 
This panel allows you to show or hide the on-screen items, which can be useful when you have a lot of screen objects 
displayed, or when the objects you want to edit are affected by objects on different layers. 

Items can be filtered by type or name, and you can use the torch icon to select or deselect all items in the list first. 

 

 

 

 

 

 

 

Fig. 30 Filter Items Panel Tabs 

8.4.1 To filter items 
1. Go to Project Navigator and select the level that you want to edit. 

2. Select the Filter Items Panel. 

3. Select the appropriate filter tab. 

4. Use the check boxes to deselect or reselect individual items. 

Note: The ‘Filter by name’ tab is context sensitive and will only show the items already included on that level. 

To show or hide all items 

5. Click the torch icon to toggle all items off or on. 

6. Use the check boxes to reselect or deselect items. 
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9 Creating a New Project 
1. Log in as Admin 

2. Click Editor mode (1).  

3. Click New Project (2) to start a new project, even if another project version is already open.  

 
Fig. 31 Creating a New Project 

• The New Project Window dialog opens: 

 

 
Fig. 32 Creating a New Project Dialogue 

4. Here you enter: 

• Project Name (Required). 

• Project location - Click the [Choose] and browse to where the project is to be saved (Required - Default is location 
will be the C:\ drive). 

• Project Description (Optional). 

• Title Prefix (Optional). 

• Scene Size (Optional). Type in the scene width and height in pixels (default setting is your monitor resolution). Note 
that choosing the wrong size will cause the images to scale to the wrong size, which will create sliders for moving 
the scene, but may also hide some buttons and features off-screen. 

2 

1 
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Tip: Make background size the same as the image being inserted. 

• Default background colour (Optional). Click the square button to select from a range of basic colours or input RGB 
(Red, Green, Blue) values to specify a colour. Clicking [Add to custom colours] allows a specified colour to be added 
to the swatch panel for future use.   

 

5. Click [Next] open the Initial l Level Images dialogue box allowing you add the site plans and a home page. This can be a 
single level or a multi-level project. The Home Level could be a photograph or a floor plan depending on your own 
preferences. 

Note: It is recommended at this stage that just the home image and building level images are added. 

 
Fig. 33 Initial Level Images Dialogue 

6. To add a level image, click [Add]. 

7. Browse to the location and insert the desired image by either double clicking your selection or clicking [Open] in the 
window. 

8. In the Level Properties tab you can enter: 

• Name – Name level image (Optional). 

• Description – Give the level name a description (Optional). 

• Background Colour – Set a background colour (Optional). Methods are as described previously. 
 

9. Use the Background Position tab to position your image in the scene: 

 
Fig. 34 Position Image 

• Check [Scale to fit] to uniform scale the image to the scene (Optional). 

• Check [Centre background] to centre the image to the scene (Optional). 

• Click and drag in the preview pane to manually adjust the image position within the scene. Note [Centre 
background] and [Scale to fit] unchecked. 

Note: Further info on image positioning can be found in the following section. 

10. Add more levels as required. Levels can be removed at this stage by clicking on the level (so it is highlighted) then 
clicking remove. 

11. Click [Finish] when done 
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9.1 Project Levels 
The term ‘Levels’ can be attributed to floor levels in a building, rooms, areas, zones, and can be configured to lead to other 
targets with the aid of hotspots, macros etc. 

Levels can be assigned, unassigned, promoted, demoted or assigned as the Home page by editing the Project Navigator 
Panel’s Sidebar levels. 

By default, the 2D GUI provides a Sidebar to navigate to assigned levels within the current ‘project’, but you can also add 
additional, customised navigation buttons that do a similar thing while displaying more detail about the target. 

Note: In Editing mode the sidebar is hidden and control buttons are deactivated as they are editable themselves, so you 
must use the Project Navigator Panel to select the level you want to work on.  

 Further information regarding the level Sidebar can be found later in this section. 

9.1.1 To add a Level image 
1. Go to the Project Navigator Panel, select the [Levels] tab, and click [Add] to open the Add dialog: 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Fig. 35 The Add Levels Dialog 

2. Click [Add] again. 

3. Navigate to the folder holding your site images 

 

Fig. 36 Images folder 
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4. When you click your chosen file it automatically imports, and you have the choices of having it centred or offset, and/or 
full-scale or scaled to fit. 

Tip: Double clicking a single file imports it without waiting for confirmation. You can also batch import by using 
[Shift+click] to select, or [Ctrl-click] to select, followed by [Open]. You can then edit your preferences for each 
level if required. 

Tip: You may want to leave space at one side of the image if you intend to add Navigation Buttons later on, or you can 
change the image layout in Level properties at any time. 

 

Fig. 37 Imported Level image dialog 

5. You can open the Level properties tab and give the image a descriptive name and description and choose a 
background colour if desired. 

 

Fig. 38 Level Properties dialog 

6. Now add any remaining levels as described above. 

7. Click OK when finished. 

8. Click the [Save] or [Save Version] Icon regularly to save your changes. 
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9.1.2 Organising Levels (Sidebar) 
The levels are displayed in alpha-numerical order when imported. Using the Sidebar feature it is possible to arrange levels in 
a preferred fashion, for instance promoting floor levels for logical building/project navigation. 

 

Fig. 39 Example Sidebar 

In Editor Mode, viewing the Project Navigator Panel, Sidebar tab, you are presented with two columns – Unassigned Levels 
and Sidebar Levels. The left/right, up/down arrows allow the user to manipulate the levels accordingly. 

The example shown below depicts a typical project whereby Levels intended for the Sidebar have been allocated. Selecting 
an Unassigned Level and clicking the right arrow enables this, moving the level to the Sidebar column. 

Levels moved to the Sidebar can be arranged as necessary by selecting the level and using the up/down arrows. The level 
moved to the top becomes the home level and, in the Sidebar, will be depicted with the ‘house’ symbol. 

 

 

Note: Maximize or move your panel if you can’t see the arrows at the bottom. 

Remember to [Save] or [Save Version] to save your changes, and then log off > log on if you want to rearrange the Project 
Navigator Panel Levels order to match the side-bar order. 

Tip: Select the Levels tab and, if you see pink levels, it means that the current level edits haven’t been saved. 

 

9.1.3 Edit level properties 
The process for editing the properties of existing levels is the same as described above but is started by going to the Project 
Navigator Panel, clicking the chosen Level, then clicking [Level Properties]. 

Clicking the [Choose] button will allow you to replace the current image. 

9.1.4 Remove level 
To remove a level: 

In the Project Navigator Panel Levels tab, select an image and click [Remove]. 

Use left/right arrows to 
move selected Levels 
between Unassigned 

and Sidebar columns. 

Use up/down arrows 
to move selected 
Levels Sidebar order. 

Top Level = Sidebar Home 
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9.2 Fire Alarm Entities  
Having imported Loop Explorer 2 configuration data (explained in the Project Prerequisites section), fire alarm entities can 
be assigned to the project levels. 

From the Project Navigator Panel, select the Object Model tab.  

The example below shows a typical configuration: 

 

Sub-menus provide the following information: 

• Object Tree – Displays the fire alarm system based on the configuration in a ‘tree’ format.  
o Clicking on each ‘+’ expands on each entity, ultimately displaying individual properties. Clicking on ‘-‘ thereafter 

collapses the expansion. 

• Equipment List – Displays the fire alarm system based on the configuration in a list format.  
o Clicking on ‘Name’ sorts entities by name, in alphanumerical order.  
o Clicking on ‘Location’ sorts entities by location, in alphanumerical order. 

• PA Zone – Displays any public address entities forming part of the fire alarm system. 

 

Through each subsystem it is possible to search for entities using key words. 
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9.2.1 Assigning Entities to Locations 

Important. 

To assign entities to their exact location in the building it is advised the ‘as built’ drawings, produced by the fire systems 
company, detailing the fire system, are to hand. These drawings will provide an invaluable means to identify and ensure 
entities are placed in the correct locations. 

 
From the Object Model subsystem, fire alarm entities, using the mouse can be ‘dragged and dropped’ to their corresponding 
Level locations. The example below displays the ‘drag and drop’ process: 

 

Here we see how the call point has been placed in its corresponding location on the Level. Note how detailed information 
about the device is displayed in the properties panel. 

Tip. The same process can be followed through Equipment List and PA Zones tabs. 
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9.3 Symbols 
Ockular uses symbols images held in a library under the Project Navigator Panel - Symbols tab.  

Symbols represent a selection of commonly used fire alarm panels, detectors and associated devices. Symbols can be 
dragged and dropped on levels to replicate the fire alarm system. 

Symbols representing fire alarm panels, detectors and devices associated with the fire system project will be automatically 
imported with your project configuration, allowing them to be dragged and dropped into the relevant place. 

Other library symbols can be imported within Ockular. Away from Ockular, Symbols can be created and imported, provided 
they meet the criteria outlined later in this section. 

9.3.1 To add symbol images to a Level 
1. From the Project Navigation Panel [Levels] tab, select the level where symbols are to be added. 

 

2. From the Project Navigation Panel click the [Symbols] tab. 

 

3. Click and drag the symbol you would like to add to your level. You can then move them, resize them, and set their 
properties. 

  

 

Tip. Pausing on a symbol with the 
pointer will show the symbol 
description. 
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9.3.2 Symbol Properties 
Through the Properties Panel, symbols can be configured by the user.  

 

Fig. 40 Symbols – Properties Panel 

Project Navigator has the following tabs with their sub menus: 

• Base 

o JPC Path: Provides intrinsic details in relation to the selected symbol. 
o Description: Optional. Add a description to the selected symbol as required. 
o Location: Optional. Add a location details to the selected symbol as required. 
o Contains Path: Used to group items. 
o JPC Source: Provides intrinsic source details in relation to the selected symbol. 

• Appearance 

 

Fig. 41 Symbols – Properties Panel – Appearance 

o Bounds - X/Y/Width/Height: Measured in pixels, adjusting values, ‘X’ axis (left and right) and ‘Y’ axis (up and down) 
allows the user to change position of the selected symbol. 
 

o Z-Index – Measured in pixels, adjusting the values, the Y axis changes the ‘height’ of the symbol. Added symbols 
are allocated Z-Index numbers in the order they are added, so it is possible to stack some symbols on top of other 
symbols depending on their Z-Index. E.g. a Sounder with index 100005 could sit on top of BGU 100004 but would 
be below BGU 100007. This might have potential where the user adds and defines a hotspot or macro button, and 
afterwards adds and drags a symbol on top of it for ease of identification.  
 
Z-Index numbers can be manually edited, but this is not recommended as you can’t know what numbers are already 
in use or what may be allocated in the future. It is also unwise to change the number of ‘0’s in a Z-Index, as they 
control the z-layer alert priority bands. e.g. a zone would be 100X whereas a symbol would be 10000X. 

You cannot change the Z-Index of the base layer image, as it is always the lowest fixed level. 
 

o Base Image – Using the base image function it is possible to change the selected symbol image type. With the level 
symbol selected, left click on the Base Image field to display the symbols library list. Select the desired symbol to 
change. 

 
Note Up/down arrow buttons change selected symbol position in one-pixel increments. The round arrow button returns 

the value to the default setting.  
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• Flag 

 

Fig. 42 Symbols – Properties Panel – Flags 

o Offset – Option changes flag position associated with the symbol the in X/Y axis. Checking the Drop Shadow box  
 

• Faults 

 

Fig. 43 Symbols Properties Panel – Faults 

o Check the transparent box to toggle on/off the associated device inputs. Generally used for testing and cause and 
effect purposes.   

9.4 Hotspots 
Hotspots are selected screen areas that, when clicked, jump you to their designated target view. 

Hotspots can be bordered or invisible, but the mouse cursor changes to a clickable hand cursor when hovering over them. 

Hotspots can be created or edited in the Editor mode. 

 

 

 

 

 

 

 

 

Fig. 44 Sample Hotspot selection 
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9.4.1 Creating a Hotspot 
1. Go to the Home view and centralize the area you want to include in your Hotspot. 

2. Click the Hotspot icon (circled below), and then click you start point. 

3. Draw your hotspot outline, clicking at each corner, and joining the first and last points. The completed hotspot will 
become filled. (The outline and fill can be edited for style and colour if required.) 

4. You can still use the sliders if your next point is off-screen, as the plot line follows the cursor until the next corner is 
clicked. 

5. Press [Esc] to cancel an incomplete shape, or [Select] > select > [Del] to remove completed shapes. 

Note: The shape fill does not appear on-screen in Control mode, and the outline can be selected to ‘on’ or ‘none’ using 
[Stroke Style]. 

 

 

 

 

 

 

 

 

 

 

Fig. 45 Completed Hotspot 

 

6. When you are happy with your hotspot area, click the [Select] icon, and then click the hotspot shape to select it. 

7. Select the Properties Panel [Base] tab and change the [Target] drop-down menu to your chosen level. 

8. Click the Save or Save Version icon. 

9. Repeat for other hotspots. 

10. Go to Control mode and test that the Hotspots work as expected. 

 

 

 

 

 

 

 

 

Fig. 46 Completed Hotspot 
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9.5 Shapes and Lines 
You can add rectangles, ellipses, regular and irregular polygons, and lines to the current level, and you can control various 
attributes (colour, fill, borders) depending on the shape. You can also change two shapes into one compound shape by 
using the grouping and transforming tools. 

1. To add a shape, click the appropriate shape icon, and then set the stroke, fill and points you want to use. 

2. Click where you want the shape to appear on screen. Click again to add more of the same shape. 

3. Click the [Select] icon, and then click your chosen shape. Ctrl-click to select multiple shapes. 

4. You can use the handles to move or resize selected shapes  

5. You can use the drawing tools to align or resize groups of shapes. 

6. You can also change the outline and fill of all the selected boxes. 

7. You can use icons or right-click to move shapes in front or behind other shapes, but Buttons must always be at the top 
or they won’t work. 

Note: Remember to click the Save or Save Version icon regularly to record and update your changes, and again when 
you have finished adding all your text boxes. 

9.5.1 To merge or cut two shapes 
1. Add two shapes as shown above. 

2. Stack the shapes and move them until you can visualize the desired shape outline. 

3. Ctrl-click to select both shapes. 

4. You can now hover over the icons to see the options of: 

• Minus the Back shape 

• Minus the Front shape 

• Merge both shapes 

• Leave only the Intersection of both shapes. 

5. Click your choice of action. If you don’t like what happened, [Ctrl-Z] or click the undo icon, and then try again. 

6. When you are satisfied with the transformation, you can group the transformed shape with another shape and repeat as 
necessary. 

  
 

Basic Shapes Shapes selected Minus Front 

 
 

 

Minus Back Merge Intersection 
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9.5.2 To add Zones to a level or to split levels 
Zones are irregular polygons drawn to surround specific areas or levels, and they can be colour coordinated and allocated to 
one of three types: 

• Detection Zones 

• Evacuation Zones 

• Operational Zones 

Zones can overlap, can be duplicated on split levels, and can be filtered by type as the need arises. 

1. To start, it is a good idea to click the grid icon, which overlays the image with faint 10x10 grids to help make the 
irregular polygon lines straight if required. 

2. Select the level on which you want the zone. 

3. Click the zone icon, and then click the Zone type drop-down menu and select a zone type. 

4. Click and release a start point and drag your first line. When you are happy with its position, click again to set the corner 
point. 

5. Drag the second line and click to create the next corner point. A shaded triangle will appear between the two sides. 

6. Repeat for the third and fourth (and more) sides, making sure that your final point joins your initial point. This is 
confirmed when the shading turns solid. 

Tip:  Holding down the <shift> key between clicking points will cause lines to be created in 45° increments. 

7. Press [Escape] if you want to discard the shaded zone and start again, but a solid zone must be selected and deleted 
as if it is an object. 

8. When you have completed your zone(s), click the [Select] icon and then select your chosen zone. 

9. Separate the Project Navigator Panel (PNP) from the Properties Panel for ease of access. 

10. Select the Properties Panel [Base] tab 

11. Select the PNP [Object Model] tab, then the Subsystem [Fire], and then the [Equipment List] tab. 

12. Select the Zone you want to allocate (e.g. DetZone001), and then drag it onto the Properties Panel, where it will auto-fill 
the relevant fields. 

13. Click the Save or Save Version icon before proceeding to the next zone. 

Note: Two or more zones given the same Object Model details will be treated as the same zone for alert purposes. 

 

 

 

 

 

 

 

 

 

Fig. 47 Copying a zone’s details to the Properties Panel 
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9.6 Text 
Text can be added, edited and moved around like any other object on screen. Text has the same fonts and Bold, Italic, 
Underline attributes as Microsoft Office, and can have various borders, backgrounds and colours. 

1. To start adding text, click the Text icon, and then set the font attributes and the background you want to use. 

 

 

2. Click where you want the text to appear on screen and start typing. 

3. Use normal text editing techniques to change the appearance or spelling of your text. 

4. When finished typing, click the [Select] icon, and then click and drag your text box to its final location. 

5. You can use the drawing tools to align or resize groups of text boxes. 

6. You can use the handles to resize the text box, but this does not affect the text, which stays in the top-left corner of the 
box. You can also change the background of all the selected boxes. 

7. You can use the Properties Panel’s Appearance tab’s Text box to edit the text directly, but you will need at least one 
starting letter in the text box, and you must follow it with Enter to commit the changes. 

8. You can use the text box handles to resize the box to fit the new text if required. 

Note: Remember to click the Save or Save Version icon regularly to record and update your changes, and again when 
you have finished adding all your text boxes. 

Tip: Although you can’t change text alignment within its text box, you can put text boxes on top of other shapes and 
then use the drawing alignment tools to centre the text box within the shape. You can also match, or contrast, the 
text box fill and the shape fill, and you can control the appearance of borders. 
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9.7 Flags 
Both Zones and Symbols can display an alert flag generated by one or more external sources. The displayed flag is always 
the highest priority alert if several input sources send alerts. 

Alert flags are allocated a higher Z-index than symbols and zones so they always appear on top of the display. Alert flags 
can also be given a positional offset from their nominal position (centre point) so that conflicts between adjacent symbols 
can be easily resolved. 

 

 

 

 

 

 

 

 

Fig. 48 Symbol Flag Offset 

Alert flags pulse on priority-state transitions, the duration of which is configurable. 

A project’s flags, properties and settings can be customised in the 2D Editor - Edit Project Setting screen. 

 

The default alert flags are: 

 
Unknown 

 
Information 

 
Warning  Reduced Service 

 
Alarm 

 
Priority Alarm 

 
Critical 3 Alarm (Pre-Fire) 

 
Critical 2 Alarm (Fire) 

 
Critical 1 Alarm 

 
Auxiliary Alarm 2 Implicit Disablement) 

Table 7.  Default Alert Flags 
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9.8 Navigation Buttons 
Navigation buttons can be created to change the current viewing ‘level’ to their designated target level. The navigation 
buttons can be assigned the following properties: 

• Main button text (mandatory) 

• Description text (optional) 

• Target page (mandatory) 

• Font Name (mandatory) 

• Font base size (mandatory) 

• Icon (optional) 

• Accessory icon (optional) 

 

 

 

 

Fig. 49 User-created Navigation buttons 

 

 

 

 

Fig. 50 Navigation button variations 

9.8.1 To add optional Navigation Buttons 
This section shows you how to add customized navigation buttons that can give four types of information instead of just one. 

Note: You have the choice of having the buttons anywhere on top of the image or dragging the image off-centre to allow 
space for manually tiling the buttons. 

 

 

 

9.8.2 To create a button 
1. Use Project Navigator to go to your Home page. 

2. Click the button creation icon, and then click in your chosen location to place the button: 

 

 

 

 

3. Click to place more buttons if required or click [Ctrl-z] to undo any mistakes. 

4. Click the Select arrow icon, and then click a button to select it: 

 

 

 
5. Use the centre handle to drag the button to a new location or use the outside handles to resize the button. You can also 

use the drawing tools to align or resize groups of buttons to the size and position of the first button. 
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6. Now you must enter the button properties to change its appearance and target destination. 

7. To do this, first select the correct button, then open the [Properties Panel] > [Base] tab and enter, as a minimum, the 
target level from the drop-down list. 

8. Enter an optional Description (which appears as the sub-description on the button). 

9. Click [Enter] to update the button. 

10. Next, open the [Appearance] tab, and enter the button’s main description as Text. 

11. Click [Enter] to update the button. 

12. You will see that the button now has text, so you can now change the font attributes, and add icons if required. 

Note: Once an icon has been used, it cannot be reused without first selecting a different icon and then selecting the 
wanted icon again. 

Note: Button names (Name) are allocated in the order you create them; you can change them manually, but this is not 
usually necessary. 

13. You do not need to change the drop-shadow or flag offset for navigation buttons, so keep the defaults. 

14. You do not need to change the Fault tab transparency setting for navigation buttons. 

15. You can use the drawing tools to add outlines with various coloured fills if you want to make the buttons stand out 
against their background. 

16. You can use icons or right-click to move shapes in front or behind other shapes, but Buttons must always be at the top 
or they won’t work. 

Note: Remember to click the Save or Save Version icon regularly to record and update your changes, and again when 
you have finished adding all your navigation buttons. 

 

 

 

 

 

 

 

 

 

 

 

 

Fig. 51 Navigation button properties 

17. To complete, toggle to Control mode and test that the Navigation buttons work as expected.  
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9.8.3 To add Macro buttons to a level 
Adding Macro buttons is the same procedure as adding Navigation buttons, the only difference is that you allocate a 
[Function] rather than a [Target], and there are no icons or sub-titles. 

The following Macro functions are currently available: 

Show Schematic Fire: Open Contact Fire: Start Find Mode 

Fire: Create maintenance log Fire: Reset Panel Fire: Start Poll 

Fire: Close Contact Fire: Silence Buzzer Fire: Simulate Fire 

Fire: Enable Device Fire: Silence Panel Fire: Stop Find Mode 

Fire: Disable Device Fire: Show In Status Tree Fire: Stop Poll 

Fire: Disable Zone Fire: Show In Maintenance Page Fire: Stop Zone Test 

Fire: Enable Zone Fire: Show Operational Procedures Workstation: Suppress Audible Alerts 

Fire: Evacuate Zone Fire: Start Zone Test CCTV / PIS: (TBC) 

TEST 

 

 

 

 

 

 

 

 

 

Fig. 52 Macro Button Properties 
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10 Saving a Project 
As you edit a project you should be saving it regularly, but you can also save project versions (see next section) or you can 
save the entire project to consolidate all of the incremental changes. 

18. To save the entire project (with the same project name), click the [Save project] button: 

 

Fig. 53 Save Project Button 

19. Enter details (Option): 

 

 

 

 

 

Fig. 54 Save Project Enter Details 

20. Click [Ok]. 

 

Note:  The change record can be viewed using edit project settings: 

   
 

 
 

Note: There is a difference between saving a project and saving Oculars’ configuration. i.e. you cannot use Ockulars’ 
View menu or keyboard shortcuts to save a project or project version. 
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11 Saving a Project Version  
Saving time-stamped versions allows you to reopen and save an earlier version if things go wrong, and it is always wise to 
save the current project as a project version before making any changes to it. 

21. To save a version, click the [Save project version] icon: 

 

22. Input details of the changes (option): 

 

 

 

 

 

 

23. Click [Ok], and your project version is time-stamped and saved to the project folder under ‘versions: 

 

 

 

 

 

 

 

 

 

Tip: To view your saves, you can click the [Restore project version] button           to shortcut to the versions folder. 
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12 Exporting a Project 
You may want to export a project to a new location, e.g. to a server, FTP site or to cloud storage, for others to use. 

To export a project: 

1. Load the project or version you want to export 

2. Click the [Export project] button: 

 

Fig. 55 Export Project Button 

3. Select a destination different from your current project directory, and then click [Select Folder]: 

 

 

 

 

 

 

 

 

Fig. 56 Export Target Directory Dialogue 

4. Your project has been saved (with the same file name) to the destination folder. 

5. If you try to save to the same directory you will get this error message: 

 

 

 

 

Fig. 57 Export Project Failed  

Tip: Use Ockular to open the exported project if you want to test its integrity. 
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13 System Configuration 
The left-hand side of the screen contains a user-sensitive System configuration menu that only shows the buttons granted 
by your log-on permissions.  

 

Fig. 58 System Configuration Menus for a full-access user 

13.1 2D GUI Control Mode toolbar 
Control Mode has two buttons that toggle between the two modes shown below: 

 

 Puts the 2D GUI into Select Mode. Allows navigation of the GUI via menus, buttons, hotspots 
and macros. 

 

Puts the 2D GUI into Fire Coverage Mode and allows the user to filter the results by: 

• Detection Zones 

• Evacuation Zones 

• Operational Zones 

• Manual Evacuation 

13.2 Sidebar 
This editable / hide-able menu is found on the left of the 2D GUI Main View screen, but the Home button and Level select 
buttons are hidden if a project only has one level. 

 This dialog shows the current page or screen. 

 
Home Button 
This button returns the user immediately to the pre-set Home view. 

Level select buttons. 
These user designated buttons allow quick access to the chosen level on the floor plan. 
Levels need not be confined to physical levels; a large floor plan may also be created to show a 
number of virtual or split levels. 

 
Edit Button 
Sited at the bottom of the screen, this icon toggles the UI between [Select] mode and [Editor] 
mode. 

 

  



 System Configuration 

Kentec Electronics Ltd. Man-1443 Rev.01 

Ockular Installation and Configuration Guide Page 56 of 115 

13.3 2D GUI 
The [2D GUI] button’s only function is to take you back to the Home screen. 

13.4 Alarm Config 
The [Alarm Config] button opens the Alarm configuration table, from where you can filter the displayed results, can create 
new alarms, copy existing alarms, or delete alarms: 

 

 

 

 

 

 

Fig. 59  Alarm Configuration Page 

13.5 Alarm Status 
Clicking the [Alarm Status] button gives you access to: 

• Alarm List 

• Alarm Event History 

• System Event Log 

• Additional Alarm Information 

• Suppressed Alarms Table 

13.5.1 Alarm List 
The [Alarm Status] button opens a tabbed System Alarm Status page where you can filter the displayed results using the 
buttons, drop-down menus and column headers. 

 

 

 

 

 

 

 

 

 

Fig. 60 Alarm Status Page 
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13.5.2 Alarm Event History 
The [Alarm Status] > [Alarm Event History] button opens a page where you can organize and filter the Alarm Event History 
using column sorting, drop-down menus and various filters. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Fig. 61 Alarm Event History Page 

13.5.3 System Event Log 
The [Alarm Status] > [System Event Log] button opens a page where you can organize and filter the System Event Log 
using column sorting, drop-down menus and various filters. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Fig. 62 System Event Log Page 
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13.5.4 Additional Alarm Information 
The [Alarm Status] > [Additional Alarm Information] button opens a page where you can organize and filter the Additional 
Alarm Information (if any) using column sorting, drop-down menus and various filters. 

Fig. 63 Additional Alarm Information Page 
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13.5.5 Suppressed Alarms Table 
The [Alarm Status] > [Suppressed Alarms Table] button opens a page where you can organize and filter the Suppressed 
Alarms Table information (if any) using column sorting, drop-down menus and various filters. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Fig. 64 Suppressed Alarms Table Page 

13.6 Archiving 
Clicking the [Archiving] button opens a page where you can view, create, copy or delete a Database Archiver Configuration, 
as shown in the figure below. 

Note: If you enter a frequency of >24 hours, Ockular will convert it to days and hours. 

 

 

 

 

 

 

 

 

 

 

Fig. 65 Database Archive Configuration Page 

Tip: You can open. move and resize multiple dialogs, as shown in the figure above. 
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13.7 Fire 
Clicking the [Fire] button gives you access to: 

• Fire System 

• Maintenance 

• Event History 

• FAS Topology 

• Alarm List 

• Status Tree 

Note: The page defaults to the Alarm list on opening, and attempts to resync every 10 seconds. 

13.7.1 Fire System 
Selecting the [Fire System] button opens this page, from where you can select, acknowledge or print further report styles. 
You can also see a visual representation of the selected zone, with options to move or resize, and the ability to move up, 
down, left or right to see different evacuation zones. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Fig. 66 Fire System 
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13.7.2 Maintenance 
Clicking the [Maintenance] button opens the following page: 

Note: Nodes and devices shown in this figure are by example. 

 

Fig. 67 Maintenance Home Page 

Selecting from the list of nodes populates the equipment list beneath. Upon selecting a device, the following options are 
available: 

• Enable selected device 

• Disable selected device 

• Start polling selected device 

• Stop polling selected device 

• Operate selected equipment 

• Restore selected equipment 

Tip: Use click, [Shift+click] or [Ctrl-click] to select your panel first and then your equipment, or use the filter tools to find 
specific items in a long list. 

Selecting at least one item from the Equipment list enables the [Enable]/[Disable] buttons, which gives you the choice to 
disable / enable your selections, or to manually create a Maintenance Log entry. 

Upon initiating any of the above options, you will be prompted to enter a descriptive reason as to why the action has been 
undertaken. At least one character must be entered to proceed. 
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13.7.2.1 Create a Maintenance Log Entry 

There are several ways to create Maintenance log entries, but this is the quickest. 

6. Click [Fire] > [Maintenance] > [Maintenance Log] > [New] to open the Log Creator dialog.

7. The Creator dialog defaults to local system time and date, but this can be changed by using the control buttons or by
dragging the clock hands.

8. Add or edit your log entry.

9. Choose whether or not to keep the dialog open for additional entries (circled below).

10. Click [Create]:

Fig. 68 Log Entry Creator Dialog 

Tip: Currently you can’t add Asset Codes when you create an entry, but you can edit them afterwards. 

13.7.2.2 View, Edit or Delete a Maintenance Log Entry 

There are several ways to manage Maintenance log entries, but this is the quickest. 

11. Click [Fire] > [Maintenance] > [Maintenance Log], and then double-click the log entry you want to view, edit or delete.
This opens the Log Inspector dialog, which you can use to make and apply your changes:

Fig. 69 Log Entry Edit or Delete Dialog 
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13.7.2.3 Create a Maintenance Log Report 

There are several ways to create Maintenance log entries, but this is the quickest. 

12. Click [Fire] > [Maintenance] > [Maintenance Log] >[Report] to open the Print Preview dialog. 

13. Edit the report settings. 

14. Use the icons to change the layout if required. 

15. Click [Generate Report] when ready: 

 

 

 

 

 

 

 

 

 

 

 

 

Fig. 70 Report Print Preview Dialog 

13.7.2.4 Export a Maintenance Log File 

Exported log files are saved as .csv file types to enable opening in your default program (e.g. MS Excel or Libre Calc). 

16. Click [Fire] > [Maintenance] > [Maintenance Log] >[Export] to open the file manager dialog. 

17. Choose a file name and location. 

18. Click [Save]. 
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13.7.2.5 Active Events 

Click [Fire] > [Active Events] to open the tables of Active Events. From this page you can filter by specific event types, by 
Quick Filter, or by Advanced Filter (Boolean Search). 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Fig. 71 Active Events Page 

13.7.2.6 Maintenance Log 

There are several ways to create Maintenance log entries, but this is the quickest. 

19. Click [Fire] > [Maintenance] > [Maintenance Log] > [New] to open the Log Creator dialog. 

20. The Creator dialog defaults to local system time and date, but this can be changed by using the control buttons or by 
dragging the clock hands. 

21. Add or edit your log entry. 

22. Choose whether or not to keep the dialog open for additional entries (circled below). 

23. Click [Create]: 

 

 

 

 

 

 

 

 

Fig. 72 Log Entry Creator Dialog 

Tip: Currently you can’t add Asset Codes when you create an entry, but you can edit them afterwards. 
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13.7.2.7 View, Edit or Delete a Maintenance Log Entry 

There are several ways to manage Maintenance log entries, but this is the quickest. 

24. Click [Fire] > [Maintenance] > [Maintenance Log], and then double-click the log entry you want to view, edit or delete. 
This opens the Log Inspector dialog, which you can use to make and apply your changes: 

 

 

 

 

 

 

 

 

Fig. 73 Log Entry Edit or Delete Dialog 

13.7.2.8 Create a Maintenance Log Report 

There are several ways to create Maintenance log entries, but this is the quickest. 

25. Click [Fire] > [Maintenance] > [Maintenance Log] >[Report] to open the Print Preview dialog. 

26. Edit the report settings. 

27. Use the icons to change the layout if required. 

28. Click [Generate Report] when ready: 

 

 

 

 

 

 

 

 

 

 

 

 

Fig. 74 Report Print Preview Dialog 

13.7.2.9 Export a Maintenance Log File 

Exported log files are saved as .csv file types to enable opening in your default program (e.g. MS Excel or Libre Calc). 

29. Click [Fire] > [Maintenance] > [Maintenance Log] >[Export] to open the file manager dialog. 

30. Choose a file name and location. 

31. Click [Save]. 
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13.7.3 Event History 
The Event History page shows all historic events with additional information (if available). The history can also be used to 
create reports, or it can be exported as a .csv file. 

The Event History can be very long and detailed, so authorized users can view and/or rearrange it by: 

• quick filter (e.g. Loop). 

• clicking column headings. 

• changing time/date periods. 

• choosing event type and sub-type. 

• using an [Advanced Filter] tool (i.e. drop-down menus for Columns + Operands + Data). 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Fig. 75 Event History Page 

 

 

 

 

 

 

 

 

Fig. 76 Event History – search categories 
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13.7.3.1  Advanced Filter Options 

In addition to the Column options shown below, users can apply the following operands and matching search parameters, 
where <n> equals a number and <x> is a string: 

• = equal to <n> 

• != not equal to <n> 

• > greater than <n> 

• >= greater than or equal to <n> 

• < less than <n> 

• <= less than or equal to <n> 

• Like… <x> 

 

 

 

 

 

 

 

 

 

 

Fig. 77 Advanced Filter Options Dialog 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

  

ADVANCED SEARCHES AND FILTERS 
Ockular reports allow both simple and advanced searches to narrow down a specific data type or series. 

Advanced filtering can use column headings with the following Boolean expressions plus free-text Data: 

• = equal to 

• != not equal to 

• > greater than 

• >= greater than or equal to 

• < less than 

• <= less than or equal to 

• Like... 

You can only currently create one filter term, so sometimes you may need to think about what to exclude 
rather than what to include… 

Example: [Zone = 2] would show only events that are listed for Zone 2, whereas [Zone != 2] would show all 
events except those in Zone 2. 
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13.7.4 Fire Alarm System (FAS) Topology 
The FAS Topology page lists all connected devices and shows their current Status and Operational Status. 

The classes can be expanded or condensed by clicking the [+] or [–] icons. 

 

Fig. 78 FAS Topology Page 

13.7.5 Alarm List 
The [Alarm List] button opens a list of all the alarm events, with an itemized summary of alarm types at the bottom of the 
screen (circled). 

The list can be re-ordered alphanumerically by clicking the appropriate column header. 

 

 

 

 

 

 

 

 

 

 

 

 

Fig. 79 Alarm List Page 

Fig. 80 Alarm List Page 

  



 System Configuration 

Kentec Electronics Ltd. Man-1443 Rev.01 

Ockular Installation and Configuration Guide Page 69 of 115 

13.7.6 Status Tree 
The [Status Tree] button opens an expandable tree layout of your Fire Alarm Control network and attached devices. You can 
use it to drill-down to see the current status and alert types of any listed item. 

Double click any item to expand or condense it, or use the [+] or [–] icons to expand or condense whole classes of items. 

Note: The values are controlled by the item type; some will return three values while others will return seven. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Fig. 81 Status Tree Page 
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13.8 Account Management 
Clicking the [Account Management] button allows you to manage all your user accounts, permissions and passwords. 

Frames and columns are resizable to enable easier reading of long descriptions. 

 

 

 

 

 

 

 

 

 

 

Individual User profiles can be managed. Under Manager User the flowing option are available: 

• Import 
o Import a previously exported User profile (.xml format). 

• Export 
o Export a User profile. 

• Refresh 
o Refreshes the User prelist. 

• Add 
o Create a new User. 

• Clone 
o Allows the administrator to ‘clone’ a User profile.  

Note: This feature can be useful where a shorter character length Username is desired. 

• Delete 
o Delete a User. 

 

Group User profiles can be managed. Under Manager Groups the flowing option are available: 

• Import 
o Import a previously exported User Group (.xml format). 

• Export 
o Export a User Group. 

• Refresh 
o Refreshes the User Group list. 

• Add 
o Create a new User Group. 

• Clone 
o Allows the administrator to ‘clone’ a User Group. 

• Delete 
o Delete a User. 
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13.9 Fire Configuration 
The [Fire Configuration] page allows you to configure or change Network settings, or to import device data and Loop 
Explorer configurations (if used). 

13.9.1 The Panel Comms Page 
This page controls the Panel Type (Syncro, Syncro AS or Taktis etc.), Panel Communication (IP or Serial port), and it allows 
you to test the connection at any time. 

 

Fig. 82 Panel Comms Page 

  



 System Configuration 

Kentec Electronics Ltd. Man-1443 Rev.01 

Ockular Installation and Configuration Guide Page 72 of 115 

13.9.2 Fire Configuration Page 
The [Fire Configuration] page allows you to import and view the fire alarm system configuration. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Fig. 83 Fire Configuration Page 

13.9.3 Advanced setting 
This is an engineering function and should not be adjusted unless advised by the manufacturer. 
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13.10 Workstation Configuration 
The [Workstation Config] button allows authorised users to access many configuration options, as shown in the left-hand 
menu below. These menu options are discussed in the following sections. 

 

Fig. 84 Global Configuration Change Page 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Note: Configurations and projects are not the same thing. A typical configuration file export is about 12 Kb, while an 
exported project folder holds many files. 

Tip: Training and development projects can be exported, and then imported if they require further work. 

Tip: Although it is not recommended, Configuration files can be directly edited at source using an appropriate text-only 
editing tool, following which they can be imported to update the current project. 

 

CAUTION 

Workstation configuration changes can have serious consequences that could affect your Ockular system’s 
functionality or security. 

To allow configuration recovery, you should export your current configuration or the entire project 
before making any configuration changes. 

CAUTION 

Due to the potentially adverse consequences of experimenting with live systems, you should enable the 
Demonstration mode for training or project creation scenarios. 

Always import or reload your Operational configuration or project when finished. 

CAUTION 

Workstation configuration changes can be made in Control Mode or Editing Mode, so Operational 
configuration changes should be restricted to specifically authorised persons only. 
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13.10.1  General Configuration 
Allows the user to add site name to the project. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Fig. 85 General Configuration Page 

13.10.2 Printing 
Use this page to change or confirm the Ockular default print settings. 

Expand on print actions 

The Default Printer drop-down menu shows the printers already added to your workstation. 

Note: Choose [Direct to Printer] if you may need to print screen grabs of site plans for emergency responders, or [Copy 
to Clipboard] if you want to include screen grabs in documentation. 

 

Fig. 86 Print Configuration Page 
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13.10.3 Sound 
For audible warnings, select the output device from the drop-down list. Click ‘Test’ to verify the output. 

13.10.4 Monitors 
Use this page to change or confirm the Ockular monitor settings. 

Select [Split Screen] and move the slider to control how much of the available monitor screen width is owned by Ockular. 

 

Fig. 87 Monitors Configuration Page 
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13.10.5 Alarms 
Use this page to change or confirm the Ockular Alarm configurations. 

 

Fig. 88 Alarms Configuration Page 

13.10.5.1 Alarm Labels and Colours 

Alarms are organised in order of priority and Alarm labels and colours can be edited by name and colour. 

Click on the name to rename an alarm label (1). 

Tip: If a mistake is made [Ctrl+z] reverts previous. 

Clicking on a colour swatch (2) opens the Select Colour picker window: 

 

The Alarm Colour can be changed by using the palette of Basic Colours (4), by selecting from the colour picker (5) or entering 
specific numerical values (6). Any generated colours can be added to the Custom colours palette by clicking the Add to Custom 
colour button (7). 

13.10.5.2 Audible Alerts 
Audible alerts can be assigned to alarm events. If this feature is required, locate the desired audio file on your PC by clicking the 
‘Browse’ button. Audio files in .wav format are supported. The Deadband (sound off) and Interval (sound on) periods can be set in 
milliseconds (ms) by entering values in the relevant boxes. Audible Alerts can be previewed by clicking the preview button. 

1 

2 

3 

4 

5 

6 

7 
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13.10.6 Language 
Use this page to import and assign language packs relevant to your country or base of operations. Language files must be 
the *.qm file type. See Appendix A Glossary for more information. 

Note: Ockular will be supplied with a default language for the region or country of first use, and additional languages 
can be purchased on request. Please speak to your local distributor or sales person for more information. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Fig. 89 Languages Configuration Page 

13.10.6.1 To import a language pack 

32. First go to [Workstation Config] > [Language] and check if the required language is already installed / activated. 

33. If not installed, save the language pack file (*.qm) into a [Languages] folder in <your chosen directory>. 

34. Go to [Workstation Config] > [Language] and click [Browse]. 

35. Find and select the language pack file you want to import, and then click [Open]. 

36. Make sure that the correct file appears in the Select File: box (Fig 59). 

37. Use the drop-down boxes to find and assign your chosen language and region. 

38. Click [Import], and then check that the new language pack is shown under [Installed language packs]. 

13.10.6.2 To activate a language pack 

39. First go to [Workstation Config] > [Language] and check if the required language is already installed. 

40. Click the chosen language to select it. 

41. Click [Activate Language Pack]. 

13.10.6.3 To remove a language pack 

This might be required if you want to replace an installed language pack with an updated one. 

Note: You cannot uninstall the default language. 

42. First go to [Workstation Config] > [Language] and check if the required language is installed. 

43. Click the chosen language to select it. 

44. Click [Remove Language Pack]. 
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13.10.7 Event Log 
The Event Log page can be used to configure and schedule the archiving of events. By default, Archive events are saved on 
the host PC typically: C:/Users/username/documents/ockular_archive/alarmeventlog. If necessary, the archive location can 
be changed by clicking on the [Change…] button and specifying another location.  

Archive items are retained thereafter, for the period specified, selected from the ‘Archive items older than’ option. 

 

Fig. 90 Event Log configuration page 

13.10.8 Licensing 
This page is not specifically a configuration tool, but can be used to check your Dongle’s licence details. 

Note: You cannot log start Ockular without a valid dongle licence. 

 

Fig. 91 Licence checking page 
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14 2D GUI Project Settings 
New Ockular projects always start with default settings, which can be edited, or reset to defaults, at any time. 

1. To edit project settings, click the [Edit Project Settings] button: 

 

 

 

Fig. 92 Edit Project Settings Button 

2. …which opens this dialog: 

 

Fig. 93 Project Setting Dialog 

3. On the General settings [Flags] tab you will see that: 

• you have the option to reset or cancel any changes you make. 

• the project name and path are auto-filled 

• the Project Description and Title Prefix are for free text entry 

• all measurements are in pixels (px) 

• ‘flags’ refer to alert icons and their placement on the background graphics 

• ‘flag offset’ refers to the centre coordinate of the flag, which can be offset if concurrent flags are very close to each 
other. 

• ‘Cycle zone states’ refers to allowing the preview image to cycle through the colour states set in the [Fire Zone] tab. 
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4. If you change to the General settings [Fire Zones] tab you will see:

Fig. 94 Fire Zones tab 

• A list of the alert states, each showing their default colour overlay, which can be visualised on the preview window.
Each state has a drop-down box showing the alternative colours or cross-hatching styles you can use; e.g. visually
impaired persons might benefit from using cross-hatch instead of colour overlays.

• A slider that allows you to control the opacity, with a reset option

5. The [Monitored Subsystems] tab only lists the monitored sub-systems in your network, and these can be deselected if
required.

6. The [Vendor Logic Rules] tab allows you to [Add] or [Duplicate] customised flags using JCOP/Openfire processing
rules. More information can be found on https://www.igniterealtime.org/projects/openfire/.

Fig. 95 Vendor Logic Rules tab 

https://www.igniterealtime.org/projects/openfire/
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7. Click [Ok] to add your new Rule, or [Cancel] to discard your changes. 

8. Click [OK] (which closes the Project Settings dialog) and then Save or [Ctrl-S] your changes.  

9. The [Change Log] tab records saved changes. 
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15 Restoring a Project Version 
Ockular boots up using the last saved configuration. If the screen canvas is blank, or if there is an error or omission, you can 
either try restoring a project version (if one was created) or load an existing, saved project. 

15.1 To restore a project version: 
10. Enter [Editor] mode 

11. Click [Restore project version]: 

 

 

12. Highlight your saved project and click [Select Folder]: 

 

 

 

 

 

 

 

 

Fig. 96 Select Project Version 

Note: Do not click the folder itself as it will open and appear to be empty. 

 

13. Click [Yes] to replace the current version: 

 

 

 

 

Fig. 97 Confirm Restore Project Version 

14. This should load a working copy of your project but, if not, you should either load a different version or create and save 
a new project. 

Note: Restored versions should be thoroughly reviewed before you save them again. 
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16 Repairing Ockular 
You can fully repair Ockular and all its dependencies, or you can incrementally repair it by choosing not to repair Openfire or 
PostgreSQL. 

An unsuccessful Ockular-only repair can be repeated with Openfire and/or PostgreSQL selected, but if this second attempt 
fails you should do a complete uninstall/reinstall procedure. See Uninstalling Ockular Section for further information. 

Note: Repairing Ockular causes the wizard to uninstall and then reinstall the selected components, so you 
should ensure that your Ockular configurations and projects have been recently backed up or exported 
prior to carrying out the repair. 

16.1 To repair Ockular using the Installation Repair tool 
1. Exit from Ockular and remove the Dongle. 

2. Start the Ockular install program that you used for the original install. 

3. Authorise UAC to change your computer settings (if asked). 

4. Select Repair and then click [Next]: 

 

 

 

 

 

 

 

Fig. 98 Repair Ockular 

5. Select the dependencies you want to include in the repair, and then click [Next]: 

 

 

 

 

 

 

 

Fig. 99 Repair Packages 

6. Check the details are correct, and then click [Repair]: 

 

 

 

 

 

 

Fig. 100 Confirm Repair 
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7. Wait until the uninstall is completed, check that the Dongle is removed, then click [Install]: 

 

 

 

 

 

 

 

 

Fig. 101 Ready to Install 

8. Select one of the options below, and then click [Finish]: 

 

 

 

 

 

 

 

Fig. 102 Finish Repair Wizard 

Note: The repair procedure doesn’t check the Dongle during the repair. However, an out of date or faulty dongle will stop 
you logging in to Ockular. Consult your distributor or Kentec Technical Support if you require further help (Details 
on back page.). 
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17 Uninstalling Ockular 
You should use the Ockular Installation software removal tool to uninstall Ockular and its dependencies, although other 
methods will also work. 

You should not uninstall Openfire or PostgreSQL if they are used by other programs, or if you intend to reinstall 
Ockular with the same configuration settings. 

Note: Print or save all reports, and save or export the current project prior to uninstalling any software. 

17.1 To uninstall using the Installation software 
1. Exit from Ockular. 

2. Start the Ockular install program that you used for the original install. 

3. Authorise UAC to change your computer settings. 

4. Select Remove and then click [Next]: 

 

 

 

 

 

 

 

 

Fig. 103 Remove Ockular 

5. Select if you want to remove all configuration and program data, then click [Next]: 

 

 

 

 

 

 

 

 

Fig. 104 Remove all Config and Programme Data Option 
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6. Select if you want to remove Openfire and PostgreSQL, then click [Next]: 

 

 

 

 

 

 

 

 

Fig. 105 Remove Openfire and PostgreSQL Option 

7. When ready, click [Uninstall]: 

 

 

 

 

 

 

 

 

Fig. 106 Confirm Uninstall 

8. Reboot your PC or server to finish the uninstall. 
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17.2 To uninstall using the Windows software removal tool 
You should not uninstall Openfire or PostgreSQL if they are used by other programs, or if you intend to reinstall 
Ockular with the same configuration settings. 

1. Go to Control Panel>Windows Programs and Features. 

2. Click Ockular. 

3. Click [Remove]>[Next]. 

4. Select whether or not to remove all Ockular configuration and program data. 

5. Click [Next]. 

6. Select whether or not to uninstall Openfire and PostgreSQL (includes dependencies). 

7. Click [Next]. 

8. Reboot the PC or server to finish the uninstall. 

9. Go to Control Panel>Windows Programs and Features and check that the following software has been 
removed: 

• ASL Patched OGRE. 

• ASL Qt Express. 

• Keylok Driver (Windows 7) (option). 

• Ockular. 

• Openfire. 

• PostgreSQL. 

• Windows Driver Package - KEYLOK (Windows 10) (option).
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20 Abbreviations 

Abb. Description 
2D Two Dimensional on the x-y axes 

3D Three Dimensional on the x-y-z axes 

ACID Access Control and Intruder Detection 

ANS Ambient Noise Sensor 

BGM Background Music 

BGU Break Glass Unit (fire alarm) 

BMS Building Management System 

CAE Cause and Effect 

CIS Customer Information Sensor 

CSV Comma Separated Values; the .csv file type allows files to be imported into columns and rows in 
spreadsheets and databases 

DDU Data Display Unit 

DIP Dynamic IP address (see SIP) 

EOL End Of Line (e.g. alarms, CCTV, detectors, sounders, speakers) 

EOLR End Of Line Resistor 

EOLD End of Line Diode 

FACS Fire Alarm Control System 

FAS Fire Alarm System 

GUI Graphical User Interface 

GUID Globally Unique Identifier used to identify equipment on a network 

I/O Input / Output 

IP Internet Provider (networking) 

LAN Local Area Network 

LLPA Long Line Public Address 

NAC Notification Appliance Circuits 

Ockular Kentec’s control system platform and SDK 

OS Operating system (e.g. MS Windows, Android, Apple Mac, Linux, Unix etc.) 

PA Public Address 

PIDS Passenger Information Display System 

PiP Picture in Picture 

PIS Passenger Information System 

px Pixel (Picture Element – from Pics. Element.) 

PTT Press to Transmit 

qm .qm is a Qt Compiled Translation Source File 

RV Rendezvous point (Emergency vehicles) 
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Abb. Description 

SCADA Supervisory Control and Data Acquisition system 

SIP1 Static IP address (see DIP) 

SIP2 

Session Initiation Protocol (SIP) is a communications protocol for signalling and controlling 
multimedia communication sessions in applications of Internet telephony for voice and video calls, 
in private IP telephone systems, as well as in instant messaging over Internet Protocol (IP) 
networks. 

SMS Station and building Management System / Site Management System 

SOP Site (or Standard) Operating Procedures 

TCP/IP Transmission Control Protocol/Internet Protocol 

TTS Text to Speech 

UAC User Account Control (Microsoft) 

UI User Interface 

UPS Uninterruptible Power Supply 

USB Universal Serial Bus 

UX User Experience 

VA Vital Area(1); Vulnerable Area(2); Visual Alarm/Alert(3); Voice Alarm(4) 

VDU Visual Display Unit; computer screen 

x – y 
axis 

x - y refers to screen pixel coordinates based on the available screen resolution (e.g. 1920 x 1080). 
X = the horizontal screen axis drawn left-to-right, and Y = the vertical screen axis drawn top-to-
bottom. A VDU’s nominal point of origin (x = 0, y = 0) is positioned at the top left of the screen, so a 
screen item’s nominal point of origin might be stipulated (in code) as [x = x+100; y = y + 100]. 

z axis z refers to a virtual axis running tangentially to the x-y axes; x-y-z coordinates can be used to 
create 3D objects that can pan, tilt, and rotate in virtual 3-dimensional space. 

z-index 
z-order 

Incident priorities are allocated to default layers arranged, in descending order, on the z-axis. In 
other words, the highest current priority (e.g. Fire) cannot be obscured by items of lower priority. 
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21 Ockular Keyboard Shortcuts 
These are the most useful keyboard shortcuts, but other Windows key combinations may also work. 

Some of these key combinations are restricted to Editor mode. 

All Modes 
Alt-F Opens the File menu 

Alt-F, X Opens the Exit dialog 

Alt-[F4] Closes the active window 

Alt-H Opens the Help menu 

Alt-H, A Opens the ‘About Ockular’ pop-out 

Alt-H, Q Opens The Quick Guide in Foxit Reader 

Alt-H, U Opens The User Manual in Foxit Reader 

Alt-V Opens the View menu 

Alt-V, S Save Settings 

Alt-Tab Tab through workspaces (useful when Ockular is in front of other windows) 

[Del] Delete selected items 

[Esc] Closes the currently open dialog 

[F3] Opens the Search window 

[F5] Show/Hide Main GUI 

Windows + L Lock your screen (saves you from logging out or closing Ockular) 

Windows + M Minimize all windows (useful if you want an empty desktop, especially in Windows 10) 

Editor mode 
Ctrl-A Select All  

Ctrl-A, Del Delete All Selected items  

Ctrl-C Copy the selected item  

Ctrl-G Group the selected items  

Ctrl-Shift, G Ungroup the selected items  

Ctrl-L Lock the selected items  

Ctrl-Shift, L Unlock all items  

Ctrl-V Paste the last copied item  

Ctrl-S Save Settings 

Ctrl-X Cut the selected item  

Ctrl-Y Redo the last Undo  

Ctrl-Z Undo the last change  

Ctrl-Left Click Add to a selection  

Ctrl-Page Up Send to front 

Ctrl-Page Down Send to back 

Page Up Send forwards 

Page Down Send backwards 

Alt-Up arrow Align top 

Alt-V Align vertical centres 

Alt-C Align horizontal centres 

Alt-Down arrow Align bottom 

Alt-Left arrow Align left 

Alt-Right arrow Align right 

Alt-Shift + Up arrow Distribute vertically 

Alt-Shift + Left arrow Distribute horizontally 
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Appendix A. Editor Drawing Tools Glossary 
These tools are specific to Editor mode. They are context sensitive and may be greyed out when unavailable. 

To use the drawing tools, select your level or zone, click the chosen shape, click the chosen location to insert the 
shape and then, while still holding the left mouse button, drag the shape to the required size and then release. 

Use the Select tool to select, move, edit or delete a previously added item or group. All tools use the same 
editing procedures as described under the Rectangle tool below. 

Use keyboard shortcuts (Appendix B) or undo/redo icons (Appendix C) to correct mistakes. 

There are unlimited undo/redo actions. 

Note: Moving or aligning items is relative to their respective x-y values, and does not change their z-order. 

Icon Title Description 
 Editor 

Mode 
This button toggles Editor Mode on and off. It can be found at the bottom left of the 
screen. 

 Select Enables point and click to select items or groups, or click and drag to move or resize an 
item or group (including text). 

 Text 
Opens the Text toolbar and enables point and click text insertion. Text can be edited for 
Font, Font size, Bold, Italic or Underline, RGB Colour, and Background type. 
Inserted text can be edited when not locked. 

 Rectangle 

Adds rectangle shapes to the image. 
Left click, drag and drop to define the outline. 
Use Select, followed by click or double-click to edit the size or shape, then use the 
outline and fill toolbar to edit the appearance. 
NB: Not using Select adds similar items when left clicking. (Ctrl-z to undo.) 

 Ellipse 

Adds ellipses and circles that can be edited, overlapped, or cut to make other shapes or 
callouts. 
Select the tool, choose the stroke and fill style, then click, drag and rotate the shape, 
and release to fix. 

 Regular 
Polygon 

Adds regular polygons that can be rotated and edited. 
Select the tool, choose the stroke and fill styles, and the number of points, and then 
click, drag and rotate the shape, and release to fix. 

 Freehand 
Polygons 

Adds freehand polygons by clicking to define freehand points and lines. The fill style 
adds shading between connected points, and shapes can be overlaid to show 2D-relief 
styles. 

 Line Adds straight lines at any angle. Lines can be edited for colour, weight and axis. 

 Zone 

Allows you to freehand draw Detection Zones, Evacuation Zones and Operational 
Zones, which become shaded as you draw. 
Select the tool, select the zone type, then click-drag-click lines around your chosen 
areas. 
Different zones can overlap. 

 Hotspot 

Allows you to freehand draw hotspots, which become shaded as you draw. 
Select the tool, select the stroke and fill styles and colours, then click-drag-click lines 
around your chosen areas. 
Different hotspots can overlap. 

 Navigation 
Buttons 

This tool adds pre-defined navigation buttons (with optional icons) at your chosen 
locations. 
Select the tool, select your font style and size, select the optional icon and accessory 
icon, then click to place your button. 

 Macro 
Buttons 

This tool adds pre-defined macro buttons at your chosen locations. 
Select the tool, select your font style and size, then click to place your button. 

 





Appendix B 

Kentec Electronics Ltd. Man-1443 Rev.01 

Ockular Installation and Configuration Guide Page 99 of 115 

Appendix B. Editor mode menu glossary 
These icons are specific to Editor mode. They are context sensitive and are greyed-out when unavailable. 

Note: Moving or aligning items is relative to their respective x-y values, and does not change their z-order. 

# Icon Description # Icon Description 

1 New Project 28 
Size Selected Items to the 
Height of the First Item 

2 Open Saved Project 29 
Distribute Selected Items 
Vertically 

3 Restore Project Version 30 
Distribute Selected Items 
Horizontally 

4 Save Project 31 Zoom In 

5 
Save Project Version 
(time-stamped) 32 Zoom Out 

6 Reload Project 33 Reset Zoom (1:1) 

7 Export Project 34 Toggle Grid Display 

8 Cut Selected Items 35 Toggle Guides Display 

9 Copy Selected Items 36 Edit Project Settings 

10 Paste Selected Items 37 Edit Symbol Library Settings 

11 Undo 38 
Toggle Alarm Flag 
Placeholder Visibility 

12 Redo 39 Minus Back 

13 Group Selected Items 40 Minus Front 

14 Ungroup Selected Items 41 Merge 

15 Lock Selected Items 42 Intersection 

16 Unlock All Locked Items 43 Select and Edit Items 

17 
Move Selected Items to the 
Front 44 Add Text Items 

18 
Move Selected Items to the 
Back 45 Add Rectangle Items 

19 
Move Selected Items 
Forward 46 Add Ellipse Items 

20 
Move Selected Items 
Backward 47 Add Regular Polygon Items 

21 Align Selected Items Top 48 Add Polygon Items 

22 Align Selected Items Middle 49 Add Line Items 

23 Align Selected Items Bottom 50 Add Zones Items 

24 Align Selected Items Left 51 Add Hotspot Items 

25 Align Selected Items Centre 52 Create Navigation Buttons 

26 Align Selected Items Right 53 Create Macro Buttons 

27 
Size Selected Items to the 
Width of the First Item 54 Toggle Editor Modes 
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Appendix C. Default icon glossary 
This appendix lists alert symbols and icons that can be saved and used in customised 2D GUI projects. (Also see 
Appendix E, Example user icons.) 

Users can also create or download their own icons, and this is explained in Sec. 4.5. Symbols Library. 

Icon Description Icon Description 

Priority Alarm 
Auxiliary Alarm 1 
(Simulated Fire) 

Critical Alarm 1 
Auxiliary Alarm 2 
(Implicit Disablement) 

Critical Alarm 2 
(Fire) 

Auxiliary Alarm 3 

Critical Alarm 3 
(Pre-Fire) 

Auxiliary Alarm 4 

Alarm Auxiliary Alarm 5 

Warning Auxiliary Alarm 6 

Reduced Service Hide this page 

Unknown occurrence Information 

Table 8. Default Alert Icons 
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Appendix D. Example user icons. This table contains some common 
UK icon examples that can be copied for use with Ockular, if 
required. (Also see Appendix D, Default Alert Icon Glossary.) 

Users can also create or download their own icons, and this is explained in Sec. 4.5. Symbols Library. 

Icon Description Icon Description 

Taktis Panel Syncro AS Panel 

Break Glass Unit Sounder 

Building Isolator Fire Department Connection 

Fire Hazard Div. 1 
(Mass Explosion risk) 

Fire Hazard Div. 3 
(Sporadic Explosion risk) 

Fire Hazard Div. 3 
(Mass Fire risk) 

Fire Hazard Div. 4 
(Safety class explosives) 

Emergency Exit Fire Exit 

Direction Arrow Assembly Point 

Escape Route 
Rendezvous Point for 
Emergency Vehicles 

Access Control Wheelchair access 

CCTV Eye wash station 

No mobile phones No PA / PIS 

Access forbidden No Smoking 

Warning Red 
0 

Warning Yellow 

Warning Black Warning Electricity Red 

Warning Electricity Yellow Warning Electricity Black 
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Icon Description Icon Description 

 
Non-Ionizing Radiation 

 
Non-Ionizing Radiation 

 
Non-Ionizing Radiation 

 
Ionizing Radiation 

 
Laser hazard 

 
UV hazard 

 
Bio-hazard Yellow 

 
Bio-hazard Black 

 
Electrostatic hazard 

 
Explosion hazard 

 Asbestos hazard 
 

Call Point 

 
Electrician 

 
Mechanic 

 Panel 
Normal 

 Panel_05 
Alarm 

 Panel_01 
Unknown error 

 Panel_06 
Priority Alarm 

 Panel_02 
Information 

 Panel_07 
Critical Alarm 

 Panel_03 
Warning 

 Panel_08 
Critical Alarm 1 

 Panel_04 
Reduced Service 

 Panel_09 
Critical Alarm 2 

 Sensor 
Normal 

 Sensor_05 
Alarm 

 Sensor_01 
Unknown error 

 Sensor_06 
Priority Alarm 

 Sensor_02 
Information 

 Sensor_07 
Critical Alarm 

 Sensor_03 
Warning 

 Sensor_08 
Critical Alarm 1 

 Sensor_04 
Reduced Service 

 Sensor_09 
Critical Alarm 2 

Table 9.  Examples of Common User Icon 
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Appendix E. Manage Groups Glossary 
Default User Group permissions follow the rules below, although users can add additional customised groups if 
required. 

Individual users can belong to multiple groups. 

Default Group Name Description 
Administrators Users who administer the Ockular system and its components 

Maintainers Users who maintain the Ockular system and its components 

Managers Users who supervise Operators, but with additional powers 

Operators Ordinary users of the system, dealing with the day-to-day operation and alerts 

ClearAlarmsGroup Users who can clear alarms 

ClearHardAlarmsGroup Users who can clear ‘hard’ alarms 

EnableDisableAlertsGroup Users who can enable and disable alarm reporting 

<Add Group Name> User defined additional groups 

Table 10.  Default Group Names 

A.1. Manage Tokens Menu 
The Tokens listed below have check-boxes that allow authorised users to assign or remove permissions from 
individual system group names (see above) as and when they are installed on your Ockular system. They can also 
be filtered to show the assigned items only. 

Ticking the top-level box for each token selects every component, ticking and then unticking it deselects everything, 
and expanding the group allows you to select or deselect individual components in that group. 

Note: Unavailable tokens are denoted by ‘TBD’ at the top level (in software), and their listed components are 
currently unavailable (although selectable). 

Note: Ockular is supplied with many items ticked by default, even if that Token / GUI isn’t yet available. These 
ticks are suggestions only, and are intended to be used as a starting point for further editing. 

Token Components Description 

2D GUI TBD Adds/Removes full access to the 2D GUI functions 

2D GUI Editor Allows the user to launch the 2D Editor 

2D GUI Project Settings Allows the user to change the project settings 

2D GUI Symbol Library Allows access to the symbol library 

Edit 2D GUI System Symbols Allows the user to change the system symbol library 

3D Editor TBD Adds/Removes full access to the 3D Editor functions 

3D Editor Allows the user to launch the 3D Editor 

3D Editor Access Level Sets the access level to the 3D Editor 

3D Editor Access Level 1 Grants Access Level 1 to the 3D Editor, if this is not explicitly set 
via the ‘3D Editor Access Level’ 

Open Alternate Model Allows the user to load a previously saved model version, 
replacing the current model 

Recalculate CCTV/PA Coverage Allows the user to trigger a recalculation of the coverage areas, 
which can take some time 

Recalculate Fire Zone Map Allows the user to trigger a recalculation of the Fire zone map, 
which can take some time 

Reload 3D Model 
Allows the user to reload the 3D Model without exiting the 
application. Note that some settings are not fully applied without 
an exit and restart 

Save 3D Model Allows the user to save their changes to the 3D Model 

Save 3D Model 
(Incremental Version) 

Allows the user to save a snapshot version of the 3D model that 
can be reloaded later on. 

ACS TBD Adds/Removes full access to the ACS functions 

Access Control GUI Allows the user access to the basic Access Control System 
Functions. Several functions require additional permissions. 
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Token Components Description 

Administration  Adds/Removes full access to the Administration functions 

Alarm Configuration GUI 
Allows the user access to the alarm configuration tables, where 
the behaviour of individual alarms or groups of alarms can be 
tailored to match site requirements 

Group point permissions Allows Group point permissions to be managed 

Per-user permissions Allows permissions to be set on a per-user basis, in addition to 
being granted to groups (of which users are members) 

Account Management GUI Allows users access to the Account Management GUI 

Database Management Editing Allows the user to modify the database management schedules 

Database Management GUI 
Allows the user access to the database management schedules, 
where the routine (scheduled) archival and clean up of system 
databases is controlled 

User Permissions GUI Allows the user to access the User Permissions GUI 

BMS TBD Adds/Removes full access to the BMS functions 

Building Management GUI Allows the user access to the basic Building Management System 
GUI 

CCTV TBD Adds/Removes full access to the CCTV functions 

CCTV GUI Allows the user access to the basic CCTV functions. Several 
functions require additional permissions. 

Full Camera Access Allows the user to view all CCTV cameras 

Full Monitor Access Allows the user to control all CCTV displays associated with their 
current workstation 

CCTV Coverage Mode Allows the user access to CCTV coverage mode (showing all 
covered areas in the 3D GUI 

Create Shared Sequence Allows the user to create new shared CCTV Sequences (editing 
existing shared sequences is a separate permission) 

Cancel all CCTV Alarm Events Allows the user to delete the current alarm event from a CCTV 
alarm monitor 

Delete Any Sequence Allows the user to delete any CCTV sequence, including shared 
sequences and personal sequences created by other users 

Delete Monitor Layout Allows the user to delete saved monitor setups 

Cancel Primary CCTV Alarm Event Allows the user to all alarm events from a CCTV alarm monitor 

Delete Shared Sequences Allows the user to delete shared CCTV sequences 

Edit Sequence 
Allows the user access to the CCTV Sequence Editor. Where 
sequences can be stored after editing is controlled by separate 
permissions 

Load Monitor Layout Allows the user to load a previously saved CCTV monitor setup 

Full Sequence Editing Allows the user to save changes to any CCTV sequence 

User Sequence Editing Allows the user to save changes to their own personal CCTV 
sequences 

Shared Sequence Editing Allows the user to save changes to shared CCTV sequences 

Modify Monitor Layout Allows the user to save the current CCTV monitor setup for later 
recall, overwriting an existing named setup 

CCTV PA Integration Allows the user to trigger PA announcements to the zone covered 
by a given CCTV camera view 

Play Sequences Allows the user to recall and play back a previously saved CCTV 
sequence (either personal or shared) 

Save Monitor Layout Allows the user to save the current CCTV monitor setup for later 
recall 

Full screen / Split screen Allows the user to change a CCTV Monitor between full screen or 
quad screen modes 

Tracker Mode Allows the user access to CCTV tracker mode (double click on the 
map to show relevant cameras) 

TBD Adds/Removes full access to the Fire functions 
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Token Components Description 

Fire Fire Maintenance Functions Allows the user to access the Maintenance pages within the Fire 
GUI 

Operational Procedures Allows the user to view the stored Operational Procedure 
documents within the Fire GUI 

View Imported Diagrams Allows the user to view the imported evacuation policy diagrams 
(as pdf’s) 

View Active Events Allows the user to view all active events on the Fire System 

View Active Fires Allows the user to view the list of active fire events on the Fire 
System 

View All Fire Management Info Allows the user to access all fire management information pages, 
the list of active fire events and all strategy and policy pages 

Auto-population of 3D GUI Allows the user to access the ‘auto-population’ feature, where 
device location information can be imported into the 3D Model 

Cause and Effect Strategy GUI Allows the user to view the installed Cause and Effect strategies 

Output Control Allows the user to set the state of contacts (or digital outputs) in 
the Fire System if these have been configured 

Poll Analogue Value Allows the user to poll an analogue value from a device 

Manual Refresh Allows the user to trigger a discrete read from a device 

Enable and Disable Equipment 
Allows the user to enable and disable fire devices within the Fire 
System. This is distinct from disabling them only within the 
Ockular GUI 

Enable and Disable Zones Allows the user to enable and disable entire zones within the Fire 
System, if the system supports this operation 

Evacuation Strategy GUI Allows the user to view the installed Zonal Evacuation strategies 

Export Tables Allows the user to export the data from tables in the Fire GUI to a 
file 

Fire System Topology View Allows the user to view a graphical tree of the Fire System devices 
in their logical hierarchy 

Find Mode Allows the user to place a device into Find Mode and remove it 
from that mode if this is supported by the underlying system 

Generate Reports Allows the user to generate reports from tables in the GUI, where 
this is supported 

Historical Events Allows the user to view historical events on the Fire System 

Maintenance Log Allows the user to view the maintenance logs of the Fire System 

Zone Certificates Allows the user to view the stored certificates (documents) for 
zone testing on the Fire System 

Fire Mode Allows the user access to Fire Mode in the 2D / 3D GUI 

Acknowledge Events Allows the user to acknowledge general events 

Manual Evacuation Allows the user to manually evacuate zones from the GUI 

Acknowledge Fire Events Allows the user to acknowledge fire events on the Fire System 
itself from the GUI 

Operational Zone Strategies Allows the user to view the stored Operational Zone Strategy 
documents within the Fire GUI 

Print Procedures Allows the user to send stored documents to the printer from the 
onscreen document viewer 

Reception Points Allows the user to view the stored reception points in the Fire GUI 

Reset Fire Devices Allows the user to reset equipment on the Fire System (usually the 
panels) from the GUI 

Fire System Schematics Allows the user to view the configured schematic pages in the Fire 
GUI 

Silence Fire Device Allows the user to silence the alarms on a device (usually a panel) 
in the Fire System from the GUI 

Silenced Buzzer Allows the user to silence the buzzer on a device (usually a panel) 
in the Fire System from the GUI 
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Token Components Description 

Simulate Fire Allows the user to trigger simulated fires, if this function is 
supported by the Fire Alarm System 

System Information Page Allows the user to access system information in the Fire GUI 

Test Fire Zone Allows the user to access the Test Zone function 

Fire GUI Allows the user access to the basic Fire Management GUI. Many 
functions require additional permissions 

General TBD Adds/Removes full access to the General functions 

Alarm acknowledgement Allows the user to acknowledge alarms 

Clear Hard Faults 

Allows the user to attempt to clear faults that have been defined 
as ‘Hard Faults’, which are faults that require a higher privilege 
level to clear as a clearance attempt may have particular side 
effects that must be understood 

Disable Alarm Reporting 
Allows the user to disable alarm/fault reporting from items of 
equipment. This might be used during maintenance procedures or 
in response to spurious (nuisance) faults 

Enable Alarm Reporting Allows the user to re-enable alarm/fault reporting from items of 
equipment. (See Disable Alarm Reporting) 

Clear Alarms Allows the user to attempt to clear alarms 

Clear Alarm Caches Allows the user to clear the cache of alarm data, which must be 
done to enable the ‘Unsuppress Alarm’ option 

General Table Write Access Allows the user to edit database tables that do not have a specific 
access permission 

Delete Subsystem Filter Allows the user to delete custom subsystem filters from the main 
alarm list GUI 

Exit GUI Allows the user to exit from the Ockular GUI 

Operator Alarms Only If set to >99, the user will not see low-level fault reports 

Pause Alarm History Updates Allows the user to pause automatic updates of the Alarm History 
View 

Save Column Widths Allows the user to save the current table column widths in the GUI 
via the save settings menu option 

Save Subsystem Filter Allows the user to save a selected filter set of subsystems in the 
main alarm list GUI for later recall 

Select Mode Allows the user to access Select Mode in the 2D/3D GUI 

Local Alert Volume Control Allows the user to access the local volume control for audible 
alerts generated by the GUI 

Suppress Alarm Allows the user to suppress an alarm from the main alarm list 

Export tables to CSV Allows the user to export the text of standard tables in the GUI to 
.csv files that can then be opened as a spreadsheet 

Alarm unacknowledgement Allows the user to ‘unacknowledge’ alarms 

Unsuppress Alarm Allows the user to ‘unsuppress’ an alarm from the main alarm list 

Change Password Allows the user to change their own password through the GUI 

IP Networking TBD Adds/Removes full access to the IP Network functions 

Network Monitoring GUI Allows basic access to IP Network monitoring functions 

Message Board TBD Adds/Removes full access to the Message Board functions 

Message Board Full Access 
Grants the user all permissions within the message board GUI. 
(Has the same effect as ticking all the individual permissions in this 
section.) 

Delete Messages Allows the user to delete posted messages 

Edit Messages Allows the user to edit posted messages 

Post Messages Allows the user to post new messages on the message board 

Message Board GUI Allows the user to access the built-in Message Board GUI, where 
users can leave messages for each other (e.g. at shift hand-over) 

View Messages Allows users to read messages 

TBD Adds/Removes full access to the PA/VA functions 
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Token Components Description 

PA/VA Advanced PA schedule settings Allows the user to access all of the advanced settings on a PA/VA 
schedule 

Edit PA Schedules Allows the user to edit the details of PA/VA schedules 

Enable / Disable PA schedules Allows the user to enable and disable (but not edit) PA/VA 
schedules 

View PA Schedule details Allows the user to view the details of PA/VA schedules 

Modify Messages Allows the user to modify existing audio or display messages 

Listen In Mode Allows the user to access Listen In Mode in the 2D/3D GUI 

BGM Access Allows the user to control background music (on/off) in the main 
GUI 

PA Coverage Access Allows the user to view PA coverage in the main GUI 

Emergency Message Button Allows the user to access the Emergency Message button in the 
2D/3D GUI 

PA Access Allows the user to access PA Mode. If the user also has access to 
PIDS mode, then the unified PIS mode is used 

PA Mute Access Allows the user to control PA Mute on/off in the main GUI 

Play Message Button Allows the user to access the Play Message button in the 2D/3D 
GUI 

PA/VA GUI Allows access to basic PA/VA functions. Advanced functions 
require additional permissions. 

Zone Group Select Button Allows the user to access the zone group select buttons in the 
2D/3D GUI 

PIDS Access Allows the user to access PIDS mode. If the user also has access to 
PA mode, then the unified PIS mode is used 

2D PA/VA Map support (Legacy) Allows the user to access the legacy 2D PA map 

Message Builder Allows the user to access the PA/VA Message Builder 

Message Builder Audio Messages Allows the user to build audio messages in the Message Builder 

Message Builder Display Messages Allows the user to build messages for information display units in 
the Message Builder 

Ad Hoc Message Trigger 
Allows the user to trigger messages (audio or display) from the 
GUI. Without this permission only live announcements or 
scheduled messages can be played 

Soft Push-To-Talk (Emergency) Allows the user to make emergency live PA announcements from 
the GUI 

Audio Message Support Allows the user to select and trigger audio messages 

Zone Overrides Table Allows the user to access the Zone Overrides Table 

Background Music Source Select Allows the user to access the BGM source column in Zone 
Overrides 

Display Brightness Override Allows the user to access the Display Brightness column in Zone 
Overrides 

Routine Messages Control (legacy) Allows the user to access the Routine Messages Suppression 
column in Zone Overrides 

Night Volume Override Allows the user to access the Night Volume Override column in 
Zone Overrides 

Display Message Support Allows the user to select and trigger display messages (e.g. on 
visual information displays) 

PA/VA GUI Pin Management Allows the user to change the security PIN on the PA/VA GUI, if it 
has been enabled in system configuration 

Soft Push-To-Talk Allows the user to make live PA announcements from the GUI 

Quick Messages Allows the user to access the ‘Quick Message’ feature, where 
messages can be triggered from a single dedicated button 

Message Management Allows the user access to PA/VA Message Management to record, 
rename and delete messages 

Message Scheduling Allows the user access to the PA/VA Scheduler GUI 
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Token Components Description 
Maximum Scheduled PA Message 
Priority 

Allows the user to prioritize scheduled PA messages (100 = 
maximum priority) 

TTS Messages Allows the user to create and save Text-to-Speech (TTS) messages 

PHP TBD Adds/Removes full access to the PHP functions 

Help Point GUI Allows access to basic Help Point Functions 

Answer Help Point Calls Allows the user to answer incoming help point calls 

Help Point Call Log Allows the user to view the help point call log 

Help Point Outgoing Call Page Allows the user to view the help point outgoing call page (the 
‘address book’ of help points) 

Hang up Help Point Call Allows the user to hang up an incoming help point call, once 
answered 

Place Help Point Call on Hold Allows the user to put a help call on hold 

Make Outgoing Help Point Call Allows the user to make an outgoing call to a help point 

Mute Help Point Call Allows the user to mute/unmute a help point call 

Take Help Point Call off Hold Allows the user to resume a help point call that has been placed 
on hold 

Show All Help Point Address Book Info Allows the user to see all data columns in the help point Address 
Book 

Show All Help Point Call Log Info Allows the user to see all data columns in the help point call log 

Transfer Help Point Calls Allows the user to transfer a help point call to the external line 

PIS TBD Adds/Removes full access to the PIS functions 

Assign DDU Profile Allows the user to assign a display profile to a Data Display Unit 

DDU Test Mode Allows the user to put the DDU into test mode 

Schematics TBD 

Schematics Page Selection Allows the user to view the drop-down list of schematics in the 
Schematics GUI 

Special TBD Adds/Removes full access to the Special functions 

Full Control Allows access to all features and GUIs 

Message Builder Diagnostic Panel Allows the user to see the diagnostic panel in the PA/VA Message 
Builder GUI 

Message Management Information  Allows the user to see the diagnostic panel in the PA/VA Message 
Management GUI 

Telephony TBD Adds/Removes full access to the Telephony functions 

Telephony GUI Allows the user access to the basic telephony functions. Advanced 
functions require additional permissions 

Add Telephony Contact Allows the user to add new contacts to the Telephony Address 
Book 

Delete Telephony Contact Allows the user to delete contacts from the Telephony Address 
Book 

Edit Telephony Contact Allows the user to edit contacts in the Telephony Address Book 

Make Telephone Calls 
Allows the user access to the Make Calls page in the Telephony 
GUI, and thus make calls from the SIP phone associated with their 
workstation. 

Address Book Extended View Allows the user to see all data columns in the Address Book 

Enable Speed Dialler Allows the user to access the configurable ‘Speed Dial’ buttons in 
the Telephony GUI 

Voice Recorder TBD Adds/Removes full access to the Voice Recorder functions 

Delete Voice Recordings Allows the user to delete recordings made by the Voice Recorder 
System 

Play Voice Recordings Allows the user to play recordings made by the Voice Recorder 
System 

Save Voice Recordings Allows the user to save recordings made by the Voice Recorder 
System to an external or networked drive 
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Token Components Description 
Voice Recording System GUI Allows the user access to the Voice Recording System functions 

Ockular TBD  

Ockular 2D GUI Allows the user access to the Ockular self-monitoring GUI 

Table 11.  Token Component Permissions 
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Appendix F. Ockular System Configuration Menus 

2D GUI 

Alarm Config 

Alarm Status 

Archiving 

Fire 

Alarm Configuration Table 

Alarm List 

Alarm Event History 

System Event Log 

Additional Alarm Information 

Suppressed Alarms Table 

Database Archiving Configuration 

Fire System 

Maintenance 

Event History 

FAS Topology 

Alarm List 

Status Tree 

Evac Zone Strategy 

Op Zone Strategy 

Evac Zone CAE 

Op Zone Fire Reception 

Fire Activations 

Zone Diagram 

System Information 

Active Events 

Maintenance Log 

Unmapped Items 

Zone Test Certificates 

2D GUI Home Page Control Mode: Select / Fire 
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Ockular System Configuration Menus Continued 

Fire Configuration 

Workstation Configuration 

Panel Comms 

Device Resources 

Fire Configuration 

General 

Printing 

Sound 

Monitors 

Alarms 

Language 

Event Log 

Licensing 

Import Device Resources 

Import Loop Explorer Configuration 

Connect to Fire Panel 

General Options for Ockular 

Options for Ockular Printing 

Options for Ockular Audio 

Options for Ockular Monitors 

Options for Alarm Labels / Colours 

Set Language / Import Languages 

Archive Location and Schedule 

Licensing Status Report 

Account Management Manage Users 
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Appendix G. Frequently asked questions 

FAQ Question Answer Remedy 

1 Why won’t Ockular start? No dongle, or dongle out of date. Fit a current dongle before 
launching Ockular 

2 
Why won’t Ockular start, or won’t 
run? 

Ockular is not compatible with 
your OS 

Install Ockular on a Windows 7 
system or contact Kentec 
Support. 

3 
Why does my screen appear 
wrong? New installation Either load a project or create 

and save a new one. 

4 
Why does my screen appear 
wrong? 

Changes were made and saved by 
the last user. 

Load a previously saved version 
and then save it. 

5 
Why does my screen appear 
wrong? 

Changes were made and not 
saved by you. 

Make your changes again, and 
save them. 

6 Why can’t I find the panel I want? Panels docked in the same space 
will be stacked up 

Select your panel on the tab at 
the bottom of the dock area. 
You can work on it in-situ, or you 
can drag and float it elsewhere. 

7 
Why can’t I find the menu item I 
want? 

Long menu bars may get 
shortened if there is insufficient 
space. 

Click the » at the end of the
menu to show additional items. 

8 
Why does my active dialog 
disappear and will not come back? 

You clicked outside the dialog, and 
brought the full-screen GUI to the 
front. 

[Alt-Tab] to cycle through the 
open windows until you find the 
one you were using. 

9 
Why did Ockular close 
unexpectedly? 

You may have closed the 
Bootstrap CMD window by 
mistake, and you will have lost any 
unsaved changes. 

Restart Ockular and begin 
afresh. Save regularly during 
edits. Save versions if making a 
lot of changes. 

10 
I accidentally deleted the wrong 
symbols from the Symbol Library; 
how do I get them back? 

Unfortunately you can’t undo this 
directly. 

Import fresh symbols and their 
ancillaries from your PC or 
Server or... 
Restart Ockular without saving 
the current changes or… 
Load an earlier saved version. 

11 
I imported previously deleted 
symbols, so why am I now showing 
duplicates? 

The Symbols library wasn’t 
refreshed between Delete and 
Import 

Close the Symbols Library 
between dissimilar tasks. 

12 
My Ockular ‘hangs’ during symbol 
loading and nothing works. What 
can I do? 

Make a note of the error message, 
and then close Ockular by closing 
the CMD window. 

Manually delete the offending 
image file from the directory 
folder and retry loading  the 
Ockular project. You may have 
several corrupt image files to 
delete in sequence. 



End of Document. 
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